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Networking Alpha® Signs

For the most recent update of this manual, go to: 
http://www.adaptivedisplays.com/support/network

This manual ships automatically with the following:
• Converter Box III—see “Converter Box III (pn 1088-1111)” on page 18.
• Alpha® Ethernet Adapter—see “Alpha® Ethernet Adapter” on page 22.
• MSS100 Micro Serial Server—see “Lantronix MSS100 (pn 1088-4113A)” on page 24.
• MSS485 Micro serial Server—see “Lantronix MSS485 (pn 1088-4112A)” on page 25.
• AlphaPremiere™ 9000 series signs

Revision date: 3/1/2002 9700-0112

This manual applies to these signs This manual does NOT apply to these signs:

200 series AlphaTicker™
(see the AlphaTicker™ LED Sign Installation Instructions manual, pn 9711-2401)

300 series AlphaEclipse™
(see the AlphaEclipse™ 3500 Series Sign Installation and Service Manual, pn 9711-6009)

400 series Alpha® Solar
(see the Alpha® Solar Operation and Installation Manual, pn 9705-1002)

Big Dot® AlphaVision™ InfoTracker™
(see the AlphaVision™ InfoTracker™ LED Sign Installation Instructions, pn 9711-2202)

Personal Priority Display®

4000 series

7000 series

AlphaPremiere™ 9000 series

Director™

AlphaVision™

Serial Clock

http://www.adaptivedisplays.com/support/network
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Network overview

Alpha® signs can be networked together in the following ways: 

• Wired—a network in which there is a physical connection, such as with cables and servers, 
between a PC and one or more signs. A wired network is either serial or LAN.

• Wireless—a network in which there is no physical connection between a PC and one or more 
signs. A wireless network uses transceivers.

• Modem—a network in which there is a telephone line connection between a PC and one or more 
signs. A modem network uses modems. 

• Mixed—a combination of a wired, wireless, and modem network.

Wired network—serial

This configuration is a simple serial connection, which means that a sign connects directly to the serial 
port on a PC through a cable. 

Wired network—LAN

There are several ways to connect an Alpha® sign to a TCP/IP network. However, in the 
configuration below, signs connect to an Ethernet LAN using an Alpha® Ethernet Adapter, which helps a 
PC communicate with the signs attached to that network. On some signs, this adapter is internal. On other 
signs, such as the AlphaPremiere™, an internal Ethernet adapter called a CoBox is used.

Signs can also connect to an Ethernet LAN using MSS100 or MSS485 micro serial servers. These 
configurations are documented later in this manual.

Alpha sign
RS232

Alpha signAlpha signAlpha sign

Ethernet
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2 Network overview

Wireless network—transceiver

A wireless network is an effective choice when:

• the cost of a wired connection is too expensive,

• the sign is at a greater distance than is recommended,

• you cannot physically run wiring to the sign’s location, or

• the signs may frequently change location.

 Wireless networks allow you to transfer data between PCs and signs that are not physically 
connected. A PC communicates with one or more signs through a transceiver (transmitter/receiver). One 
transceiver at the PC (the master transceiver) transmits messages to a second transceiver (the remote 
transceiver) in or attached to a sign located elsewhere.

There are two types of wireless networks:

• LAWN (Local Area Wireless Network)

• WAWN (Wide Area Wireless Network)

Adaptive Micro Systems does not provide wireless messaging hardware or technical communication 
services for most Alpha® indoor signs. If you are interested in this type of network, we recommend you 
visit the following Web sites for more information:

• WaveWare Technologies (http://www.wirelessmessaging.com)

• Reach Wireless (http://www.reachwireless.com)

• Metrocall/DirectView (http://www.metrocall.com/directview) 

 

Alpha sign
Alpha sign

Alpha sign

http://www.wirelessmessaging.com
http://www.reachwireless.com
http://www.metrocall.com/directview
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Modem network

This configuration connects signs to a PC through a modem. It is used when the signs and the PCs are 
a great distance from each other. 

Mixed network

A mixed network involves a combination of two or more network types. In the configuration below, a 
PC connects to one sign by a modem and additional signs through a serial cable:

In this configuration, a PC on a LAN is connected to an outdoor sign through a wireless network:

Alpha sign

Alpha sign

Alpha sign

Alpha sign

RS232
RS485

RS485

LAN

Alpha sign
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4 Network overview

Detailed information

To go directly to the type of network you want, use the following:

Network type Go to page

Wired networks 5

   Serial—preliminary information* 5

   Serial RS232 (single sign) 7

   Serial RS485 (single sign) 7

   Serial RS485 (multiple signs) 8

   LAN—preliminary information* 9

   LAN (single sign) 10

   LAN (multiple signs) 11

Modem networks 13

   Modem—preliminary information* 13

   Modem (single sign) 14

   Modem (multiple signs) 15

Mixed networks 16

Wireless networks—transceiver

http://www.wirelessmessaging.com
or

http://www.reachwireless.com
or

http://www.metrocall.com/directview

*Contains information you need to know prior to setting up that type of network.

http://www.wirelessmessaging.com
http://www.reachwireless.com
http://www.metrocall.com/directview
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Wired networks

Serial—preliminary information

With serial connections, either RS232 or RS485 cable is used. Selecting which cable to use depends on 
the distance from the PC to the sign:

All cables should be kept as short as possible to reduce interference and quicken the process of 
sending the data.

NOTE: Because it will not create toxic fumes, plenum cable (pn 1088-8002 and pn 7122-0283) should 
be used anytime there is either a potential for fire or where cabling is run near common 
ventilation, such as in the ceiling, near cold air returns, or as local electrical codes require. Do 
not use standard cable in these cases (pn 1088-8624 and pn 1088-8636)—RS485 connections 
only use plenum cable.

On some signs, an internal jumper must be set to either RS232 or RS485 depending on the cabling the 
sign is using (see “Appendix D—Setting the RS232/RS485 jumper” on page 49 for additional information). 
Also, some signs may need to be terminated depending upon which type of network and the number of 
signs you are using (see “Appendix B—End-of-line termination” on page 46 for additional information).

Maximum drops
In an RS485 network, the maximum number of connections (or “taps”) to a network is 32. Taps are 

also called network drops and they can include PCs, signs, servers, and so on. If more than 32 taps are 
required, use an RS485 repeater box, which boosts the electrical signal.

NOTE: Star networks, in which a PC is central to all signs on a network in a star pattern, are not 
recommended.

Cable length
In an RS485 network, signs should connect to Modular Network Adapters, similar to phone jacks, 

with a recommended adapter-to-cable length of 1 foot. This length provides optimum hardware operation 
and data transmission integrity. However, the 8-foot length will work for most installations and can still 
be used.

Distance from PC to sign Recommended cable

Less than 50 feet RS232 cable

Greater than 50 feet but less than 4000 RS485 cable*

*Additional hardware is needed to accommodate the longer distance. 

Alpha signAlpha signAlpha sign

32 drops maximum

1-foot maximum
recommended

Drop 1 Drop 2 Drop 3 Drop 4 Drop 5

RS485
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Converter Box III wiring
When using a Converter Box III, which converts RS232 signal to RS485, a maximum of two sign cables 

can connect to the back of it. Therefore, only two “strings” of signs can attach. For more information on the 
Converter Box III, see“Converter Box III (pn 1088-1111)” on page 18. 

Item Part # Description

A 1088-8634 Type A9 RS232 cable (connects Converter Box III to PC RS232 port)

B 1088-1111

Converter Box III, set to Terminated for a single sign cable or Unterminated for two sign cables.

Used with a Converter Box III AC Adapter:
pn 4011-1201 (120 volt)
pn 4011-4201 (230 volt)

C
1088-8624 8-foot RS485 cable
1088-8636 1-foot RS485 cable

D 4331-0602 Modular Network Adapter
E 1088-9107 End-of-line (EOL) terminator

NOTE 1: The information below the dotted line is the hardware to be added when you want to connect a second sign cable for 
additional signs. In this situation, the Converter Box III must be set to Unterminated.

NOTE 2: Part number 1088-8002, a 1000-foot RS485 shielded plenum cable, can replace pn 1088-8624 or pn 1088-8636.

Alpha signAlpha signAlpha sign

Alpha sign Alpha sign

(See NOTE 1 below)

A

C

D

To Converter
Box III

E

D

C

RS485

RS485 E

RS232

Sign cable 1

Sign cable 2

B
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RS232—single sign

Use this setup when you want a simple serial (RS232) connection to a PC (one sign to one PC, at a 
distance of less than 50 feet):

RS485—single sign

Use this setup when you want a simple serial (RS232) connection to a PC (one sign to one PC, at a 
distance of greater than 50 feet):

Item Part # Description

A — Ferrite (ferrite end toward sign)

B
1088-8625 25-foot RS232 cable
1088-8627 50-foot RS232 cable

C
4370-0001C RJ11-to-DB25 adapter (for a PC with a 25-pin RS232 port)
1088-9108 RJ11-to-DB9 adapter (for a PC with a 9-pin RS232 port)

Note:   Part number 1036-9010, a 6-connector RS232 cable, can replace pn 1088-8625 and pn 1088-9108.

Item Part # Description

A — Ferrite (ferrite end toward sign)

B
1088-8624 8-foot RS485 cable
1088-8636 1-foot RS485 cable (recommended)

C 4331-0602
Modular Network Adapter (See “Appendix G—Modular Network Adapter to Converter Box III wiring” 
on page 57 for specific wiring information.)

D 1088-8002 1000-foot RS485 shielded plenum cable

E
1088-1111

Converter Box III with a Converter Box III AC Adapter:
pn 4011-1201 (120 volt)
pn 4011-4201 (230 volt)

F 1088-8634 Type A9 RS232 cable (connects Converter Box III to PC RS232 port)

G — DB9-to-DB25 adapter (if PC has a 25-pin RS232 port)

Alpha sign

A B C

To PC’s RS232 or
TTL port

To sign’s RS232 
port

PC running 
messaging 
software

50 feet or less

Alpha sign

A B C

To PC’s RS232 
port

To sign’s RS485 
port PC running 

messaging 
software

Up to 4000 feet. If more, 
a repeater box is 

necessary. 50 feet or less

D E F G
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RS485—multiple signs

Use this setup when you want to connect a PC to more than one sign (two or more signs to one PC):

Item Part # Description

A 1088-9107 End-of-line (EOL) terminator 
B — Ferrite (ferrite end towards sign)

C
1088-8624 8-foot RS485 cable
1088-8636 1-foot RS485 cable

D 4331-0602 Modular Network Adapter
E 1088-8002 1000-foot RS485 shielded plenum cable

F 1088-1111
Converter Box III with a Converter Box III AC Adapter:

pn 4011-1201 (120 volt)
pn 4011-4201 (230 volt)

G 1088-8634 Type A9 RS232 cable (connects Converter Box III to PC RS232 port)
H — DB25-to-DB9 adapter (if PC has a 9-pin RS232 port)

NOTE: The information below the dotted line is the hardware to be added when you want the Converter Box III in 
the middle of the network. In this situation, the Converter Box III must be set to Unterminated.

To sign’s 
RS485 port

Alpha sign

Alpha sign

Alpha sign

Alpha sign

Alpha sign

Set switch to 
Terminated.

To PC’s 
RS232 port

PC running messaging 
software

To sign’s 
RS485 port

A

B

C D

EB D
F

HTo RS485
connector

To sign’s 
RS485 port

To sign’s 
RS485 port

A
C D

E

(See NOTE below)

To RS485
connector on

B

C

To sign’s 
RS485 port

G

B

Converter Box III
(Set switch to 
Unterminated.)
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LAN—Preliminary information

The Alpha® Ethernet Adapter, Lantronix MSS100, and Lantronix MSS485 serial servers are used to 
connect Alpha® signs to an existing TCP/IP network. Serial servers convert data from TCP/IP to serial 
format and allow you to communicate with Alpha® signs across the room or around the world.

An Alpha® Ethernet Adapter can be mounted on the back of a sign. They draw their power from the 
sign itself and no separate power supply is needed. The Alpha® Ethernet Adapter and the MSS485 serial 
server work on a 10BASE-T TCP/IP network and the MSS100 works on a 10BASE-T or a 100BASE-T 
network. For additional information on serial servers, see “Network interfaces” starting on page 17.

NOTE: Some signs have an internal Alpha® Ethernet Adapter. Other signs, such as the 
AlphaPremiere™, have an internal Ethernet adapter called a CoBox.

There are three steps to networking Alpha® signs on a TCP/IP network:

1. A unique IP address must be assigned to each serial server prior to setting up the network 
hardware in order for messages to be sent to a specific sign on the network. See “Appendix H—
Assigning an IP address to a serial server” on page 58. 

2. Set up the networking hardware using one of the configurations on the following pages.

3. Tasks specific to the messaging software you are using need to be performed once the network 
hardware has been set up. See “Appendix I—Setting up messaging software for TCP/IP 
networking” on page 70.

On some signs, an internal jumper must be set to either RS232 or RS485 depending on the cabling the 
sign is using. See “Appendix D—Setting the RS232/RS485 jumper” on page 49 for more information. Also, 
some signs may need to be terminated depending upon which type of network and the number of signs 
you are using. See“Appendix B—End-of-line termination” on page 46.
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LAN—single sign

Use this setup when one sign needs to connect to a LAN:

Item Part # Description

A — The PC must be connected to the Ethernet LAN with a network card.

B
1088-9120 Alpha® Ethernet Adapter kit
1088-4113A MSS100 Micro Serial Server
1088-4112A MSS485 Micro Serial Server

Alpha sign

A

B

PC running
messaging software

Ethernet LAN using TCP/IP protocol

100BASE-T using MSS100
10BASE-T using Alpha® Ethernet Adapter or MSS100 or MS485



Networking Alpha® Signs

Wired networks 11

LAN—multiple signs

TCP/IP network
Use this configuration when connecting signs to a TCP/IP network using unique IP addresses. The 

number of signs on this network is limited by the number of available IP addresses, but the potential 
length of the network is unlimited:

TCP/IP and RS485 network
Use this configuration when connecting multiple signs to a TCP/IP network using only one IP 

address. One MSS485 Micro Serial Server is used and up to 32 signs can connect to it. Total length of the 
RS485 network is limited to 4,000 feet at 9600 baud or 9,000 feet at 2400 baud, except if a repeater box is 
used.

Only one IP address is needed, but each sign on the RS485 network can have its own serial address so 
it can be sent messages different from other signs:

Item Part # Description

A — This PC must be connected to the TCP/IP network with a network card.

B
1088-9120 Alpha® Ethernet Adapter
1088-4113A MSS100 Micro Serial Server
1088-4112A MSS485 Micro Serial Server

C 1088-9107 End-of-line (EOL) terminator (if MSS485 is used)

Item Part # Description

A — The PC must be connected to the Ethernet LAN with a network card.
B 1088-4112A MSS485 Micro Serial Server
C 4331-0602 Modular Network Adapter

D
1088-8624 8-foot RS485 cable
1088-8636 1-foot RS485 cable

E 1088-8002 1000-foot RS485 shielded plenum cable
F 1088-9107 End-of-line (EOL) terminator

Alpha signAlpha signAlpha sign

B B B

PC running 
messaging

A

C

Ethernet LAN using TCP/IP protocol

100BASE-T using MSS100
10BASE-T using Alpha® Ethernet Adapter or MSS100 or MS485

software

Alpha signAlpha signAlpha sign

LANTRONIX

M
SS

48
5-

T

B

C

D

C

PC running
messaging software

A Ethernet LAN (10BASE-T) using TCP/IP protocol

C

D D

E

RS485

F
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Gateway network

Use this configuration when connecting one or more signs to a Gateway network:

Item Part # Description

A — This PC must be connected to the Ethernet LAN with a network card.

B —
Alpha® Gateway II interface (varies according to the specific industrial network) 
Input: 9600 baud, 8 bits, No parity, 1 stop bit, Flow Control=None
Output: 9600 baud, 7 bits, Even parity, 2 stop bits, Flow Control=None

C 1088-8002 1000-foot RS485 shielded plenum cable
D 1088-4112A MSS485 Micro Serial Server (set as local host server)

E 1088-4113A MSS100 Micro Serial Server (set as remote server)

F 1088-4112A MSS485 Micro Serial Server (set as remote server)
G 4331-0602 Modular Network Adapter

H
1088-8636 1-foot RS485 cable
1088-8624 8-foot RS232 cable

I 1088-9120 Alpha® Ethernet Adapter kit

Alpha sign

Alpha sign

Alpha sign

LANTRONIX

M
SS

48
5-

T
D

E

PC running
messaging software

Ethernet LAN (10BASE-T) using TCP/IP protocol

F

B C

Alpha sign
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H
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A
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M
S

S
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8
5
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LANTRONIX

M
S

S
4

8
5
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Modem networks

Modem—Preliminary information

In a modem network, messages are sent from the PC to a modem, called the transmitting modem, over 
telephone wires to another modem, called the receiving modem, and then to a sign. A US Robotics 56K 
modem is used for the receiving modem and must be configured before it can be used to send data to a 
sign. The transmitting modem is the responsibility of the sign owner (the same brand is recommended).

If you are using a US Robotics 56K modem for the receiving or transmitting modem, or both, the dip 
switches on them should be set as follows:

You will need to send commands to the receiving modem from either the modem’s software (here, it is 
US Robotics® Control Center software) or Microsoft’s HyperTerminal software. 

Refer to TechMemo 01-0011, Modem Setup for Alpha® signs, for additional information on 
configuring your modem. Also, since the commands necessary to change the modem’s settings vary 
between modems, the modem’s operations manual should always be consulted.

On some signs, an internal jumper must be set to either RS232 or RS485 depending on the cabling the 
sign is using. See “Appendix D—Setting the RS232/RS485 jumper” on page 49. Also, some signs may need 
to be terminated depending upon which type of network and the number of signs you are using. See 
“Appendix B—End-of-line termination” on page 46 for additional information.

Disables 
flow 

control

Modem 
ignores 

RTS

Fixed serial 
port rate

Connection 
speed = 

9600 baud

Loads
Profile Ø 

into 
NVRAM 
when 

modem is 
powered 

on.

Writes this 
current 
setup to 

Profile Ø in 
nonvolatile 
memory 
(NVRAM)

ON
1 2 3 45 6 7 8

3, 5, 8 = ON
1, 2, 4, 6, 7 = OFF

ON
1 2 3 45 6 7 8

2, 4, 5, 6, 7 = ON
1, 3, 8 = OFF

Transmitting modem Receiving modem 

AT&HØ&R1&B1&N6&YØ&WØ
This special “AT” 

command must be set 
on the receiving 

modem
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Modem—single sign (RS232)

Use this setup when you want to connect a single sign to a modem network:

Item Part # Description

A — Ferrite (ferrite end toward sign)

B
1088-8625 25-foot RS232 cable

1088-8627 50-foot RS232 cable

C —

25 pin sub-D/to 6 pos. RJ11 modem adapter
 
Visit Pacesetter Communications, Inc. at info@pace-setter.com
for more information on their part number 2370-0002.

D US Robotics® 56K Faxmodem Receiving modem

E — Telephone lines

F US Robotics® 56K Faxmodem Transmitting modem

A B C D

Alpha sign

messagingE

F

PC running

software

To sign’s 
RS232 port
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Modem—multiple signs (RS485)

Use this setup when you want to connect multiple signs to a modem network:

Item Part # Description

A 1088-9107 End-of-line (EOL) terminator

B 1086-8636 1-foot RS485 cable

C 4331-0602 Modular Network Adapter

D 7122-0283 100-foot RS485 shielded plenum cable

E 1088-1111
Converter Box III with a Converter Box III AC Adapter:

pn 4011-1201 (120 volt)
pn 4011-4201 (230 volt)

F 1088-8635 10-foot Modem-to-Converter Box cable, DB9 to DB25

G US Robotics® 56K Faxmodem Receiving modem

H — Telephone line

I US Robotics® 56K Faxmodem Transmitting modem

J Belkin F2L088-06 6-foot Belkin Pro Series AT Serial Modem cable, DB9-to-DB25

Alpha sign

J

IHGFEDC

B

To next sign

Alpha sign

PC running
messaging
software

HTo sign’s 
RS485 port

A



Networking Alpha® Signs

16 Mixed networks

Mixed networks

A mixed network is an appropriate choice in many situations. A typical configuration, in which a PC 
with two COM ports connects to one sign by a modem and additional signs through a serial cable, appears 
below:

Item Part # Description

A — Ferrite (ferrite end toward sign)

B
1088-8625 25-foot RS232 cable

1088-8627 50-foot RS232 cable

C
4370-0001C RJ11-to-DB25 adapter (for a PC with a 25-pin RS232 port)

1088-9108 RJ11-to-DB9 adapter (for a PC with a 9-pin RS232 port)

D —

25 pin sub-D/to 6 pos. RJ11 modem adapter 

Available from Pacesetter Communications, Inc. at info@pace-setter.com
for more information on their part number 2370-0002.

E US Robotics® 56K Faxmodem Receiving modem

F — Telephone lines

G US Robotics® 56K Faxmodem Transmitting modem

NOTE:   Part number 1036-9010, a 6-connector RS232 cable, can replace pn 1088-8625 and pn 1088-9108.

A B

D
E

Alpha sign

messagingF

G

PC running

software

Alpha sign

To PC’s RS232 or
TTL port

To sign’s RS232 
port

C
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Network interfaces

A network interface is used to connect two different types of networks. For example, the Converter 
Box III is used to join an RS232 and RS485 network. There are two types of network interfaces, PC-to-sign 
and sign-to-sign.

PC-to-sign interfaces connect a PC to one or more signs. PC-to-sign interfaces include:

• Converter Box III, which connects a PC’s RS232 port to an RS485 network.

• Xircom USB Adapter, which connects a PC’s USB port to an RS232 or RS485 network.

Sign-to-sign interfaces connect a sign to a serial or Ethernet (LAN) network. Sign-to-network 
interfaces include:

• Alpha® Ethernet Adapter, which connects a sign’s RS232 port to a 10BASE-T Ethernet network.

• Lantronix MSS100, which connects a sign’s RS232 port to a 10BASE-T or 100BASE-T Ethernet 
network.

• Lantronix MSS485, which connects a sign’s RS485 port to a 10BASE-T Ethernet network. 
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Converter Box III (pn 1088-1111)

Description

Item Description

A
RS232 TXD indicator. When lit, indicates that the unit is transmitting data through the RS232 plug 
and receiving data through one of the RS485 connections.

B
RS232 RXD indicator. When lit, indicates that the unit is receiving data through the RS232 plug 
and transmitting data through one of the RS485 connections.

C Power indicator. When lit, indicates that the unit has power.

D
RS485 jack. Connects a single Alpha® sign to the unit. For multiple sign networking, use the 
RS485 connector block.

E

Termination selector.

Set to Terminated if the Converter Box is at one end of a string of signs.

Set to Unterminated if the Converter Box is in the middle of a string of signs.

See “Appendix B—End-of-line termination” on page 46 for more information on terminating signs.

F RS485 connector block. Connects multiple Alpha® signs to a network.

G RS232 plug. Connects to a PC’s RS232 port.

H Power plug. Supplies 9 VAC to the unit.

1 = DCD
2 = RXD
3 = TXD
4 = DTR
5 = Signal GND
6 = DSR
7 = RTS
8 = CTS
9 = not connected

15 234

9 678

RS232 pinout

1 = not connected
2 = RS485(+)
3 = SHIELD
4 = not connected
5 = RS485(-)

51 432

RS485 pinout
6

Back

Front

A B C

D

E
FG

H

C S S S

C=Converter Box
S=Sign
T=E-O-L terminator

C=Converter Box
S=Sign

T

S S C S T=E-O-L terminator
S=Sign
C=Converter Box

TT
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Typical use

Used to connect a PC’s RS232 port to an RS485 network: 

Item Part # Description

A 1088-9107 End-of-line (EOL) terminator

B — Ferrite (ferrite end toward sign)

C
1088-8624 8-foot RS485 cable

1086-8636 1-foot RS485 cable

D 4331-0602 Modular Network Adapter

E

1088-8002 1000-foot RS485 shielded plenum cable

7122-0283 100-foot RS485 shielded plenum cable

7122-0284 100-foot RS485 outdoor shielded plenum cable

F 1088-1111
Converter Box III with a Converter Box III AC Adapter:

pn 4011-1201 (120 volt)
pn 4011-4201 (230 volt)

G 1088-8634 Type A9 RS232 cable (connects Converter Box III to PC RS232 port)

Alpha sign

Alpha sign

B C

A

G

E

To next sign

PC running
messaging software

D

F
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Xircom USB Adapter

Description

Typical use

Used to connect a PC’s USB port to an RS232 or RS485 network: 

Item Description

A RS232 serial DB9 male connector data out

B USB male connector data in

C

LED indicator light:
• Red—Power on
• Green or amber—Transmitting data
• No light—No operation 

Item Part Description

A — Ferrite (ferrite end toward sign)

B
1088-8625 25-foot RS232 cable

1088-8627 50-foot RS232 cable

C 1088-9108 RJ11-to-DB9 adapter

D — Xircom® PortGear™ USB-to-DB9 serial adapter

NOTE:   Part number 1036-9010, a 6-connector RS232 cable, can replace pn 1088-8625 and pn 1088-
9108.

A

B

C

Alpha sign

A B C

To sign’s 
RS232 port

PC running 
messaging software

NOTE: RS232 cable connection can 
not exceed 50 feet in total 
length.

D

Single sign connection

To PC’s
USB port
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Item Part # Description

A 1088-9107 End-of-line (EOL) terminator (must be plugged into the RS232 or TTL plug on last sign)
B — Ferrite (ferrite end towards sign)

C
1088-8624 8-foot RS485 cable
1088-8636 1-foot RS485 cable

D 4331-0602 Modular Network Adapter
E 1088-8002 1000-foot RS485 shielded plenum cable

F 1088-1111
Converter Box III with a Converter Box III AC Adapter:

pn 4011-1201 (120 volt)
pn 4011-4201 (230 volt)

G — Xircom® PortGear™ USB-to-DB9 serial adapter

NOTE 1: The information below the dotted line is the hardware to be added when you want the Converter Box III in 
the middle of the network. In this situation, the Converter Box III must be set to Unterminated.

NOTE 2: The internal jumper in some Alpha® signs must be set to RS485. See “Appendix D—Setting the RS232/
RS485 jumper” on page 49.

To sign’s 
RS485 port

Alpha sign

Alpha sign

Alpha sign

Alpha sign

Alpha sign

Set switch to 
Terminated.

PC running messaging 
software

To sign’s 
RS485 port

A

B

C D

EB D
F

To RS485
connector

To sign’s 
RS485 port

To sign’s 
RS485 port

A
C D

E

(See NOTE 1 below)

To RS485
connector on

B

C

To sign’s 
RS485 port

G

Multiple sign connection

Converter Box III.
(Set switch to
Unterminated.)
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Alpha® Ethernet Adapter

Description

Typical use

Used to connect a sign’s RS232 port to a 10BASE-T Ethernet network: 

Item Description

A DB25 serial port

B RJ45 TCP/IP port

C Reset button

D

LED diagnostic lights
1 = ACT (activity)
2 = LNK (network line/connection)
3 = PWR (power)

Item Part # Description

A 1088-9317 8-inch Ethernet cable, RJ11-to-DB25 (female)

B 1088-9120 Alpha® Ethernet Adapter Kit

C — TCP/IP cable (10BASE-T only)

D
1
2
3B

A

C

Alpha signAlpha signAlpha sign

Ethernet

B

A

C

C

A B(Detail)
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Additional information

The Alpha® Ethernet Adapter works with the following signs:

• 215C, 215R

• 220C (all shipped after February 1, 2000)

• 300C series

• 4000C, 4000R series (using RS232 jumper and jack)

• 7000C series (using RS232 jumper and jack)

• Alpha® Big Dot

• AlphaVision™ FS

• BetaBrite® one-line displays (P1026, P1036 and P1040), including 213C and
BetaBrite® Window Display

• BetaBrite® Director (all shipped after July 1, 2000)

• Personal Priority Display™ (PPD™)

The Alpha® Ethernet Adapter does not work with the following signs:

• 210C

• 220C (all shipped prior to February 1, 2000)

• 420

• 790i

• AlphaEclipse™

• AlphaPremiere™

• AlphaVision™ CM, FM, 1.4”, 2.1”

• AlphaVision™ Video Screen (VS)

• AlphaVision™ InfoTracker (IT) – works with MSS485 only

• AlphaTicker™ – works with MSS485 only

• BetaBrite Director® (all shipped before July 1, 2000)

• Solar™

For the most recent update, refer to TechMemo 99-0002, Valid Adaptive signs for the ALPHA 
Ethernet Adapter.
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Lantronix MSS100 (pn 1088-4113A)

Description

Typical use

Used to connect a sign’s RS232 port to a 10BASE-T or 100BASE-T Ethernet network: 

Item Description

A Power connection (5 volt only)

B Reset button

C RJ45 TCP/IP port

D

LED diagnostic lights
1. Power
2. Link (network link/connection)
3. 100
4. OK
5. Serial

E DB25 serial port (for RS232 connections)

Item Part # Description

A
1088-8625 25-foot RS232 cable

1088-8627 50-foot RS232 cable

B 4370-0001C DB25-to-RJ11 adapter

C 1088-4113A MSS100 Micro Serial Server

D –– Power cable (connects to the power, 5 volt only)

E –– TCP/IP cable (connects to 10BASE-T or 100BASE-T TCP/IP)

5VDC 10/100

serial

power
link

ok
serial

100

LANTRONIX

M
S

S
-1

00

reset

DB

C

A

E

Alpha signAlpha signAlpha sign

Ethernet

C
A

E

5
V

D
C

10
/1

00

serial

pow
er

link

okserial

100

L
A

N
T

R
O

N
IX

MSS-100

re
s

e
t

A

D

E

B

(Detail)
C
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Lantronix MSS485 (pn 1088-4112A)

Description

Typical use

Used to connect to multiple signs using one serial server.

Item Description

A Wiring terminal block

B Power connection (6 volt only)

C Reset button

D RJ45 TCP/IP port

E

LED diagnostic lights
1 = Power
2 = Link (network link/connection)
3 = OK
5 = Serial

Item Part # Description

A
1088-8624 8-foot RS485 cable

1088-8636 1-foot RS485 cable

B 4331-0602 Modular Network Adapter

C 1088-4112A MSS485 Micro Serial Server

D — Power cable (6 volt only)

E — TCP/IP cable (10BASE-T only)

L
A

N
T

R
O

N
IX

MSS485-T

serial
console

shld
txa
txb
rxb
rxa
shld

6v
dc

re
se

t
10

B
A

S
E

-T

p
o

w
er

lin
k

o
k

serial

B

C

D

A

E

Alpha signAlpha signAlpha sign

LANTRONIX

M
S

S
4
8
5
- T

serialconsole

shld
txa
txb
rxb
rxa
shld

6vdcreset10BASE-T

power

link

ok

serial

Ethernet

RS485

A B

C

E The sign’s serial
address will allow
you to talk to one
sign at a time instead
of broadcast.

L
A

N
T

R
O

N
IX

MSS485-T

serial
console

shld
txa
txb
rxb
rxa
shld

6v
dc

re
se

t
10

BA
SE

-T

pow
er

link

okserial

A D

E

C
B(Detail)
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Additional information

Switch(es) Setting Meaning

1, 2, 3 On / On / On 2-wire RS485

4, 5 On/Off 2-wire RS485 termination

6, 7 On / On RX biasing

8 Off Float shield

Revision C13/B or later is needed.
Earlier versions may not work correctly.
If you experience difficulty, contact your 
Customer Account Specialist.

On
Off

1 2 3 4 5 6 7 8

DIP switches with RS485 termination
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Network cables and adapters

Overview

Networking hardware is not possible without cables and adapters. Cables, or wires, connect pieces of 
a network together. Adapters convert one format to another:

• physical (type of plug)

• electrical (configuration of wiring)

• electronic (computer/monitor interface)

The following information describes the typical use and pinouts of the most commonly used 
networking cables and adapters.
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25-foot RS232 cable (pn 1036-9010)

Description

Typical use
Used as part of an RS232 connection between a PC with a DB9 (9-pin) COM port and a sign so that 

messages can be sent to the sign from the PC:

Pinouts

Left jack
RJ12 (male)

Right plug
DB9 (female)

Alpha sign

PC running messaging 
software

To sign’s 
RS232 

port

6-connector RS232 cable
(pn 1036-9010)

This cable can replace
pn 1088-8625 and pn 1088-9108.

To PC’s 
RS232 

port

RJ12
(male)

DB9
(female)

PIN 3
PIN 4

PIN 1

RXD
TXD

GND

Green

Red

Blue

TXD
RXD
RTS
CTS
GND
DSR
DCD
DTR

PIN 3
PIN 2
PIN 7
PIN 8
PIN 5
PIN 6
PIN 1
PIN 4

RJ12
(male)

6 1

DB9
(female)

12345

6789

Pin Signal

1 Signal GND
2 not connected
3 RXD
4 TXD
5 not connected
6 not connected

Pin Signal

1 DCD
2 RXD
3 TXD
4 DTR
5 Signal GND
6 DSR
7 RTS
8 CTS
9 not connected
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3-foot 6-conductor cable (pn 1088-8621)

Description

Typical use
Used to connect an IR Message Loader to a sign or to a PC:

Pinouts

Item Part # Description

A 1071-1113 IR Message Loader

B 1088-8624 8-foot RS485 cable

C 1088-9108 RJ11-to-DB9 connector

Left jack
RJ12 (male)

Right jack
RJ12 (male)

DATA VALID

1 2 3
MEMORY LOCATION

DATA BAT.LOW

TRANSMIT

MESSAGE
LOADER

DATA VALID

1 2 3
MEMORY LOCATION

DATA BAT.LOW

TRANSMIT

MESSAGE
LOADER

Alpha signA

B

To 
sign’s 
RS485 

port

Signs that have internal RS232/RS485 
switches (or jumpers) must be set to RS485.
See “Appendix D—Setting the RS232/RS485 

jumper” on page 49.

IR Message Loader to Alpha® sign

IR Message Loader to PC

A

B

To PC’s 
RS232 

port

C

PC running messaging 
software

RJ12
(male)

6 1 6 1

RJ12
(male)RJ12

(to IR Message Loader)
RJ12

(to Alpha® sign or computer)

PIN 1
PIN 2
PIN 3
PIN 4
PIN 5
PIN 6

GND
RS485(+)
RXD
TXD
RS485(-)
+5V

White
Black
Red

Green
Yellow
Blue

GND
RS485(+)
RXD
TXD
RS485(-)
+5V

PIN 1
PIN 2
PIN 3
PIN 4
PIN 5
PIN 6
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8-foot RS485 cable (pn 1088-8624)

Description

Typical use

Used to connect a sign to a Modular Network Adapter as part of an RS485 network:

Pinouts

Item Part # Description

A 1088-1111
Converter Box III with a Converter Box III AC Adapter:

pn 4011-1201 (120 volt)
pn 4011-4201 (230 volt)

B
1088-8624 8-foot RS485 cable

1086-8636 1-foot RS485 cable

C 4331-0602 Modular Network Adapter

D

1088-8002 1000-foot RS485 shielded plenum cable

7122-0283 100-foot RS485 shielded plenum cable

7122-0284 100-foot RS485 outdoor shielded plenum cable

E 1088-8634 Type A9 RS232 cable (connects Converter Box III to PC RS232 port)

Left side
RJ11 (male)

Right side
RJ11 (male)

Alpha sign

B C

A E

D

To next sign

PC running messaging 
software

Alpha sign

RJ11
(male)

4 1

RJ11
(male)

4 1

RJ11
(to sign)

RJ11
(to Modular Network Adapter)

PIN 1
PIN 2
PIN 3
PIN 4

RS485(+)

RS485(-)

RS485(+)
SHIELD

RS485(-)

PIN 1
PIN 2
PIN 3
PIN 4

Black*
Red*

Green*
Yellow*

*These are also the wire colors in the Modular Network Adapter.
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25-foot RS232 cable (pn 1088-8625)

Description

Typical use
Used as part of an RS232 connection between a PC with a DB25 (25-pin) or DB9 (9-pin) COM port and 

a sign so that messages can be sent to the sign from the PC:

Pinouts

Left jack
RJ12 (male)

Right jack
RJ12 (male)

Alpha sign

PC running messaging 
software

To sign’s 
RS232 

port
6-connector RS232

cable
(pn 1088-8625 or

1088-8627)

RJ12-to-DB9 
connector

(pn 1088-9108)
or

RJ12-to-DB25 
connector

(pn 4370-0001C)

To PC’s 
RS232 

port

RJ12
(male)

6 1 6 1

RJ12
(male)RJ12

(from sign)
RJ12

(to computer)

PIN 1
PIN 2
PIN 3
PIN 4
PIN 5
PIN 6

GND
RS485(+)
RXD
TXD
RS485(-)
+5V

Blue
Yellow
Green
Red

Black
White

GND
RS485(+)
RXD
TXD
RS485(-)
+5V

PIN 1
PIN 2
PIN 3
PIN 4
PIN 5
PIN 6
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8-foot RS485 back-to-back cable (pn 1088-8626)

Description

Typical use
Used to connect two signs together into an RS485 network:

Pinouts

Left jack
RJ11 (male)

Right jack
RJ11 (male)

Alpha sign

RS-485  OUT

RS-485  IN

RS-485  IN

RS-232  IN

OR

OR

WARNING-NOT A
TELEPHONE
CONNECTION.

RS-485  OUT

RS-485  IN

RS-485  IN

RS-232  IN

OR

OR

WARNING-NOT A
TELEPHONE
CONNECTION.

RS232/Aux
RS485

RS232/Aux
RS485

Alpha® 4000/7000 signs:
(RS485 ports on sign’s back) AlphaPremiere™ 9000 signs:

(RS485 ports on sign’s side)

Alpha sign

RJ11 RJ11

PIN 1
PIN 2
PIN 3
PIN 4

RS485(+)

RS485(-)

Black

Red
Green
Yellow

RS485(+)

RS485(-)

PIN 1
PIN 2
PIN 3
PIN 4

1 4 14

RJ11
(male)

RJ11
(male)
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50-foot RS232 cable (pn 1088-8627)

Description

Typical use
Used as part of an RS232 connection between a PC with a DB25 (25-pin) or DB9 (9-pin) COM port and 

a sign so that messages can be sent to the sign from the computer:

Pinouts

Left jack
RJ12 (male)

Right jack
RJ12 (male)

Alpha sign

PC running messaging 
software

To sign’s 
RS232 

port

6-connector RS232 
cable

(pn 1088-8625
 or

1088-8627)

RJ12-to-DB9 
connector

(pn 1088-9108)
or

RJ12-to-DB25 
connector

(pn 4370-0001C)

To PC’s 
RS232 

port

RJ12
(male)

6 1

RJ12
(male)

6 1

RJ12
(from sign)

RJ12
(to computer)

PIN 1
PIN 2
PIN 3
PIN 4
PIN 5
PIN 6

GND
RS485(+)
RXD
TXD
RS485(-)
+5V

Blue
Yellow
Green
Red

Black
White

GND
RS485(+)
RXD
TXD
RS485(-)
+5V

PIN 1
PIN 2
PIN 3
PIN 4
PIN 5
PIN 6
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10-foot computer-to-Converter Box III Type A9 RS232 cable (pn 1088-8634)

Description

Typical use
Used to connect a computer to a Converter Box III as part of an RS485 network:

Pinouts

Item Part # Description

A 1088-1111
Converter Box III with a Converter Box III AC Adapter:

pn 4011-1201 (120 volt)
pn 4011-4201 (230 volt)

B
1088-8624 8-foot RS485 cable

1086-8636 1-foot RS485 cable

C 4331-0602 Modular Network Adapter

D

1088-8002 1000-foot RS485 shielded plenum cable

7122-0283 100-foot RS485 shielded plenum cable

7122-0284 100-foot RS485 outdoor shielded plenum cable

E 1088-8634 Type A9 RS232 cable (connects Converter Box III to PC RS232 port)

Right side
DB9 (female)

Left side
DB9 (male)

Alpha sign

B C

A E

D

To next sign

PC running messaging 
software

Alpha sign

12345

6789

DB9
(female)

54321

9876

DB9
(male)

DB9
(male - to Converter Box III)

DB9
(female - to computer)

PIN 1
PIN 2
PIN 3
PIN 4
PIN 5
PIN 6
PIN 7
PIN 8
PIN 9

DCD
RXD
TXD
DTR
GND
DSR
RTS
CTS
RI

DCD
RXD
TXD
DTR
GND
DSR
RTS
CTS
RI

PIN 1
PIN 2
PIN 3
PIN 4
PIN 5
PIN 6
PIN 7
PIN 8
PIN 9
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10-foot modem-to-Converter Box III Type B9 RS232 cable (pn 1088-8635)

Description

Typical use
Used to connect a sign to a Modular Network Adapter as part of an RS485 network:

Pinouts

Item Part # Description

A — Transmitting modem

B — Receiving modem

C 1088-8635 10-foot Modem-to-Converter Box RS232 cable, DB9 to DB25

D 1088-1111
Converter Box III with a Converter Box III AC Adapter:

pn 4011-1201 (120 volt)
pn 4011-4201 (230 volt)

E 4331-0602 Modular Network Adapter

F
1088-8624 8-foot RS485 cable

1086-8636 1-foot RS485 cable

Left side
DB9 (male)

Right side
DB25 (male)

A

C D

To PC’s 
RS232 port

To next signEF

PC running messaging 
software

Alpha sign

B

DB9
(male)

54321

9876

DB25
(male)

13121110987654321

252423222120191817161514

DB9
(male - to Converter Box III)

DB25
(male - to modem)

PIN 1
PIN 2
PIN 3
PIN 4
PIN 5
PIN 6
PIN 7
PIN 8
PIN 9

not connected
not connected
not connected
not connected

DCD
RXD
TXD
DTR
GND
DSR
RTS
CTS

DCD
RXD
TXD
DTR
GND

PIN 8
PIN 2
PIN 3
PIN 20
PIN 7
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1-foot RS485 cable (pn 1088-8636)

Description

Typical use
Used to connect a sign to a Modular Network Adapter as part of an RS485 network:

Pinouts

Item Part # Description

A 1088-1111
Converter Box III with a Converter Box III AC Adapter:

pn 4011-1201 (120 volt)
pn 4011-4201 (230 volt)

B
1088-8624 8-foot RS485 cable

1086-8636 1-foot RS485 cable

C 4331-0602 Modular Network Adapter

D

1088-8002 1000-foot RS485 shielded plenum cable

7122-0283 100-foot RS485 shielded plenum cable

7122-0284 100-foot RS485 outdoor shielded plenum cable

E 1088-8634 Type A9 RS232 cable (connects Converter Box III to PC RS232 port)

Left side
RJ11 (male)

Right side
RJ11 (male)

Alpha sign

B C

A E

D

To next sign

PC running messaging 
software

Alpha sign

RJ11
(to sign)

RJ11
(to Modular Network Adapter)

PIN 1
PIN 2
PIN 3
PIN 4

RS485(+)

RS485(-)

RS485(+)
SHIELD

RS485(-)

PIN 1
PIN 2
PIN 3
PIN 4

Black*
Red*

Green*
Yellow*

*These are also the wire colors in Modular Network Adapter.

RJ11
(male)

4 1 4 1

RJ11
(male)
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End-of-Line (EOL) terminator (pn 1088-9107)

Description

Typical use
Connects to the RS232 (or TTL) plug of the first or last sign on an RS485 network:

Pinouts

Item Part # Description

A 1088-9107 End-of-Line (EOL) terminator

B
1088-8624 8-foot RS485 cable

1086-8636 1-foot RS485 cable

C 4331-0602 Modular Network Adapter

D 1088-1111
Converter Box III with a Converter Box III AC Adapter:

pn 4011-1201 (120 volt)
pn 4011-4201 (230 volt)

E

1088-8002 1000-foot RS485 shielded plenum cable

7122-0283 100-foot RS485 shielded plenum cable

7122-0284 100-foot RS485 outdoor shielded plenum cable

F 1088-8634 Type A9 RS232 cable (connects Converter Box III to PC RS232 port)

RJ12 jack (male)

Alpha sign

B C

D F

E
PC running messaging 

software

Alpha sign

A

PIN 6 (5V)

R3 = 680 ohms

R1 = 120 ohms

R2 = 680 ohms

PIN 2 (RS485+)

PIN 5 (RS485-)

PIN 1 (GND)

PINS 3, 4 (not connected)

RJ12

PCB

PCB

PIN 1
PIN 2
PIN 3
PIN 4
PIN 5
PIN 6

Blue
Yellow
Green
Red

Black
White

PIN 6
PIN 5
PIN 4
PIN 3
PIN 2
PIN 1

RJ12
(male)

6 1
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RJ12-to-DB9 adapter (pn 1088-9108)

Description

Typical use
Used as part of an RS232 connection between a computer with a DB9 (9-pin) COM port and a sign so 

that messages can be sent to the sign from the PC:

Pinouts

Left side
RJ12 (female)

Top

Right side
DB9 (female)

Alpha sign

PC running messaging 
software

To sign’s 
RS232 

port

6-connector RS232 
cable

(pn 1088-8625
 or

1088-8627)

RJ12-to-DB9 
connector

(pn 1088-9108)

To PC’s 
RS232 

port

RJ12
(female)

DB9
(female)

12345

6789

RJ12
(female)

DB9
(female)

PIN 3
PIN 4

PIN 1

RXD
TXD

GND

TXD
RXD
RTS
CTS
GND
DSR
DCD
DTR

PIN 3
PIN 2
PIN 7
PIN 8
PIN 5
PIN 6
PIN 1
PIN 4

1 6
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8-inch Ethernet cable (pn 1088-9317)

Description

Typical use
Used to connect a sign to an Alpha® Ethernet Adapter on an Ethernet LAN using TCP/IP protocol:

Pinouts

Item Part # Description
A — The PC must be connected to the Ethernet LAN with a network card.
B 1088-9120 Alpha® Ethernet Adapter kit
C 1088-9317 8-inch Ethernet cable

Left side
RJ11 (male)

Right side
DB25 (female)

Alpha sign

A

B

PC running 
messaging software

Ethernet LAN using TCP/IP protocol
10BASE-T using Alpha® Ethernet Adapter

A

C

RJ11
(male)

DB25
(female)

PIN 3
PIN 4
PIN 6
PIN 1

 
 
 

PIN 2
PIN 3
PIN11
PIN10

 
 

Green
Red

Blue
White

RJ11
(male)

6 1

DB25
(female)

12345678910111213

141516171819202122232425
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Modular Network Adapter (pn 4331-0602)

Description

Typical use
Used to connect a PC to a Converter Box III as part of an RS485 network:

Pinouts

Item Part # Description

A 1088-1111
Converter Box III with a Converter Box III AC Adapter:

pn 4011-1201 (120 volt)
pn 4011-4201 (230 volt)

B
1088-8624 8-foot RS485 cable

1086-8636 1-foot RS485 cable

C 4331-0602 Modular Network Adapter

D

1088-8002 1000-foot RS485 shielded plenum cable

7122-0283 100-foot RS485 shielded plenum cable

7122-0284 100-foot RS485 outdoor shielded plenum cable

E 1088-8634 Type A9 RS232 cable (connects Converter Box III to PC RS232 port)

Left side
RJ11 (female)

Right side

Top

Alpha sign

B C

A E

D
PC running messaging 

software

Alpha sign

(Red terminal) SHIELD

RS485 – (Yellow terminal)

Green terminal

NOTE:   Connecting the SHIELD depends on the sign to which you are connecting it. In 
other words, if a Modular Network Adapter is connected to an Alpha® Personal 
Priority Display sign, then connect the two SHIELD wires together from each 
RS485 cable. However, do NOT connect the connected SHIELD wires to the Red 
terminal.

RJ11
(female)

Pin Signal

1 RS485 +
2 SHIELD
3 Not connected (Green terminal)
4 RS485 –

1 4

(Black terminal) RS485 +
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RS232 cable connector (pn 4331-0603)

Description

Typical use
Used as part of an RS232 sign network to connect two lengths of 25-foot RS232 cable:

Pinouts

Left jack
RJ12 (female)

Right jack
RJ12 (female)

Top

Alpha sign

PC running 
messaging software

To 
sign’s 
RS232 

port

25-foot RS232 
cable

(pn 1088-8625)

To PC’s 
RS232 

port

RJ12-to-DB9 
connector

(pn 1088-9108)
or

RJ12-to-DB25 
connector
(pn 4370-

0001C)

25-foot RS232 
cable

(pn 1088-8625)

RS232 
cable 

connector
(pn 4331-

0603)

This distance should NOT exceed 50 feet.

RJ12
(female)

RJ12
(female)

PIN 1
PIN 2
PIN 3
PIN 4
PIN 5
PIN 6

PIN 1
PIN 2
PIN 3
PIN 4
PIN 5
PIN 6

RJ12
(female)

1 6
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RJ12-to-DB25 adapter (pn 4370-0001C)

Description

Typical use
Used as part of an RS232 connection between a PC with a DB25 (25-pin) COM port and a sign so that 

messages can be sent to the sign from the PC:

Pinouts

Left side
RJ12 (female)

Top

Right side
DB25 (female)

Alpha sign

PC running 
messaging software

To 
sign’s 
RS232 

port

To PC’s 
RS232 

port
6-connector 

RS232
data cable

(pn 1088-8625 or 
pn 1088-8627)

RJ12-to-DB25 
connector 

(pn 4370-0001C)

1 6

DB25
(female)

12345678910111213

141516171819202122232425

RJ12
(female)

DB25
(female)

PIN 3
PIN 4

PIN 1

RXD
TXD

GND

TXD
RXD
RTS
CTS
GND
DSR
DCD
DTR

PIN 2
PIN 3
PIN 4
PIN 5
PIN 7
PIN 6
PIN 8
PIN 20

RJ12
(female)
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Network messaging software

Overview

Messaging software is used to create messages on your PC and then send them to Alpha® signs. 
Depending on the software and sign you use, different features and functions are available to help you 
personalize your messages:

• Text color

• Fonts

• Modes (flashing or rotating text, for example)

• Time and date insertion

• Graphics

• Animation

• Message simulation

Alpha® Messaging Software

Alpha® Messaging Software is a software program that controls text on standard Alpha® signs. The 
software includes a Configuration Utility, as well as allows you to preview the text of your message on a 
sign. You can also specify message attributes, such as presentation styles and idle time, insert the time and 
date into a message, and select from available display animations.

Alpha® Messaging Software works with serial networks and can send messages to a single Alpha® 
sign.

AlphaNET™ Software

AlphaNET™ 2.0 is a full-featured software program that controls text and graphics on standard 
Alpha® signs. The software includes a Message Editor and a Site Editor, and full message simulation 
allows you to preview a message as it will appear on a sign prior to sending it. Image editing software is 
also included with AlphaNET™ 2.0 to help you create and edit graphics and animations.

 AlphaNET™ 2.0 software works with serial, modem, and LAN networks and can send messages to 
any individual sign or group of signs. 
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Smart Alec® Software

Smart Alec® is an extensive software system which can acquire real-time data from manufacturing, 
warehousing, or other data collection software systems, as well as manual input. Smart Alec prioritizes, 
schedules, and delivers this information to Alpha® signs, E-mail systems, and alphanumeric pagers. The 
program includes a Message Manager, Command Manager, Variable Rule Manager, and other system 
managers, as well as various start-up and advanced utilities. 

Smart Alec® works with all types of networks and runs in TCP/IP network environments on PCs 
with either a Windows® 95, Windows® 98, or Windows® NT operating system. Multiple signs can be 
connected to the PC or LAN, and Smart Alec® can send messages to any individual sign or groups of 
signs.

Alpha® Marquee ActiveX® Control

The Alpha® Marquee ActiveX® Control is a development tool that allows programmers to rapidly 
interface Alpha® signs to any application that supports the use of ActiveX controls. The control comes 
complete with everything needed to trigger alarms, string messages, and display real-time information on 
a static display. It communicates to any Alpha® sign through a serial or LAN connection.
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Appendix

Appendix A—Related documentation

The following documentation may be useful with this manual and can be found on Adaptive’s Web 
site at http://www.ams-i.com/Pages/techdoc.htm.

Part # Document name Description

9701-0202 Messaging Software User Manual
Provides step-by-step examples of how to use messaging 
software.

9702-2005 Alpha® Director™ Sign User Manual
Explains how to set up the aluminum Director™ and 
includes instructions for basic operating procedures and 
messaging with the Remote Control.

9704-0002 Alpha Remote Control Programming
Explains how to use the Remote Control to create and send 
messages to display signs.

9705-1002C Alpha®Solar™ Series Installation Manual
Describes how to mount the sign, set up the electrical 
connection, and connect the sign to a PC. Also discusses 
the basic operation of the sign.

9707-1003 IR Message Loader Instructions
Explains how to use the infrared message loader to transfer 
messages between display signs and PCs.

9707-7004 ALPHA® NEMA Series Sign Installation Instructions Explains how to install Alpha® NEMA series signs.

9708-8081 AlphaNet™ 2.0 User Manual

Explains how to install and use the version 2.0 software for 
AlphaNet™ (formerly called AlphaNet plus™ for 
Windows®.) Lengthy examples show how to set up and 
send messages to a network of signs. 

9709-2030 Smart Alec Version 3.0 User Manual
Describes how to use the Smart Alec version 3.0 software. 
Includes basic background, plus setting up and managing 
the system, as well as advanced functions.

9711-2401B AlphaTicker™ Installation Instructions Describes how to install and network AlphaTicker™ signs.

9711-4201C AlphaPremiere™ 9000 Series Installation Manual Explains how to install Series 9000 signs.

9711-6009 AlphaEclipse™ 3500 Series Installation and Service Manual
Provides comprehensive setup, installation, 
troubleshooting, and field repair for AlphaEclipse™ 3500 
series outdoor signs.

9711-6501B AlphaEclipse™ 1500 Series Installation Manual
Explains how to install, set up, and wire the sign and 
temperature probe. Also provides routine service and 
technical specifications.

TechMemo
01-0003

Installing a USB-to-DB9 adapter to connect a sign to a PC
Describes how to network signs to a PC with a USB port 
using the Xircom USB adapter.

TechMemo
01-0011

Modem setup for Alpha® signs
Describes how to set up the transmitting and receiving 
modems to Alpha® signs.

http://www.ams-i.com/Pages/techdoc.htm
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Appendix B—End-of-line termination

When an Alpha® sign is at the end of an RS485 network, a special end-of-line (EOL) terminator is 
required for the first and last sign. The EOL terminator plugs into the sign’s RS232/TTL port and stops the 
flow of communication. 

On an RS485 network, the PC that sends messages to the networked signs is wired directly to one of 
the signs using a Converter Box III, which converts the computer’s RS232 signals to RS485 signals. In this 
case, the Converter Box III must be terminated instead of the first sign in the network. To terminate a 
Converter Box III, set the switch on the back of the unit to Terminated:

Sometimes, the PC that sends messages to the networked signs is not directly connected to any of the 
signs. Instead, the PC sends messages to a modem or wireless transceiver attached to the signs. The 
messages are then relayed to the other signs in the network (using a special feature called RS485 echo):

For more information on RS485 echo, see “Appendix C—RS485 echo” on page 48.

First sign Last signMiddle sign(s)
Converter Box III
(pn 1088-1111)

set to Terminated

RS485 Termination ON

End-of-line (EOL) 
terminal or required

RS232 RS485

End-of-line (EOL) 
terminator required on this 
sign if it is the only sign. 

RS485 Termination OFF RS485 Termination OFF RS485 Termination ON

RS232

Wireless transceiver

First sign Last signMiddle sign(s)

End-of-line (EOL) 
terminator required on this 
sign if it is the only sign.

RS485

Modem 

Termination by 
dipswitch required.

RS485 Termination ON RS485 Termination OFF RS485 Termination ON
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Stand-alone Personal Priority Display®
Detailed use of the EOL terminator can be found throughout this manual. However, its use with a 

Personal Priority Display® is documented here because a special duplex adapter is needed to 
accommodate both the EOL termination and networking functions. Adaptive Micro Systems does not 
carry this adapter. To obtain one, contact Adaptive for a referral or visit your local Radio Shack.

Wall-mounted Personal Priority Display®

Item Part # Description
A — Duplex adapter
B 1088-9107 End-of-line (EOL) terminator

C
1088-8624 8-foot RS485 cable
1088-8636 1-foot RS485 cable

D 4331-0602 Modular Network Adapter
E — Ferrite (ferrite end towards sign)
F 1088-8002 1000-foot RS485 shielded plenum cable

Item Part # Description
A — Ferrite (ferrite end towards sign)
B 1088-8624 3-foot RS232 cable
C — Duplex adapter
D 4331-0602 Modular Network Adapter
E 1088-9107 End-of-line (EOL) terminator
F 1088-8002 1000-foot RS485 shielded plenum cable

Personal Priority DIsplay

A

E

To sign’s 
RS232/RS485 

port

B
D

F

C

Personal Priority DIsplay

E

A C D

F

B
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Appendix C—RS485 echo

When RS485 echo is on, data coming into a sign via RS232 is sent back out the sign controller board’s 
RS485 terminals. This allows information coming into one sign to be forwarded to other signs.

RS485 echo is best used for modem or wireless applications when the RS232 data source is inside the 
sign. However, a typical configuration is as follows:

NOTE: RS485 echo is currently available on the AlphaPremiere™ 9000 series and aluminum 
Director™ signs.

RS232

First sign Last signMiddle sign(s)

RS485

RS485 echo ON
RS485 echo OFF RS485 echo OFF

This sign is set up to echo 
the incoming RS232 signal 
to the other signs via RS485.
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Appendix D—Setting the RS232/RS485 jumper

Typically, if only one sign will be connected to a PC, the sign’s jumper is set to RS232. When 
connecting multiple signs, each sign’s jumper should be set to RS485. Some Alpha® signs have an            
RS232/RS485 auto-sensing port that sets the jumper for you automatically, and not all signs have jumpers. 
See“Appendix E—Serial and power connections” on page 51 for more information.

NOTE: Make sure the power to the sign is off before changing the position of the jumper.

Series 4000 and 7000 signs

Director™ sign

WARNING
Hazardous voltage. 
Contact with high voltage may
cause death or serious injury.
Always disconnect power 
to unit prior to servicing.

23
2

48
5

jumper
position

RS232

23
2

48
5

jumper
position

RS485

23
2

48
5

23
2

48
5

Remove the sign’s cap by 
removing these two screws.

Lift the cap off. Remove the plastic lens 
from the front of the sign 
by pulling it up. Then set 
the RS232/RS485 jumper.

When the jumper is on 
the left two pins, the 
sign is set to RS232. 
When the jumper is 
on the right two pins, 
the sign is set to 
RS485.

NOTE: This information applies to
the wood Director™ only. You do
not have to set the jumper in the
aluminum Director™ as it is set
automatically.
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Signs with a terminal block
A terminal block is a group of one or more individual terminals consisting of electrical connectors. 

Many functions can be wired to the terminal block, such as power distribution or grounding. On some 
Alpha® signs, serial connections are directly wired to a terminal block as either RS232 or RS485, so there is 
no jumper to be set. Each sign’s installation manual provides detailed instructions. 

“Appendix E—Serial and power connections” on page 51 provides information on which signs have 
terminal blocks.

Terminals

To make a connection, insert a wire under the
appropriate screw and then tighten the screw.
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Appendix E—Serial and power connections

The table below indicates the communication ports available with each Alpha® sign, where the sign 
should be terminated, whether the sign has a jumper or terminal block, and where the power connection is 
located. Detailed information can be found in the manual for each sign type on Adaptive’s Web site at 
http://www.ams-i.com/Pages/techdoc.htm:

Sign
Serial communication port

Jumper Terminal block Power
RS232/RS485 RS485

RS232/RS485 
autosensing

215 Series 215C or R X X Back of sign
220 220C X Back of sign

300 Series
320C X X Back of sign
330C X X Back of sign

400 Series 420C or R X X Inside sign

4000 Series

4080C X X X Back of sign
4120C or R X X X Back of sign

4160C or R X X X Back of sign
4200C or R X X X Back of sign
4240C or R X X X Back of sign

7000 Series

7080C X X X Back of sign
7120C X X X Back of sign
7160C X X X Back of sign
7200C X X X Back of sign

AlphaPremiere™ 
9000 Series

9080C See note 2 below X Back of sign
9120C See note 2 below X Back of sign
9160C See note 2 below X Back of sign
9200C See note 2 below X Back of sign
9240C See note 2 below X Back of sign

Big Dot® X X Back of sign
Serial Clock X X Back of sign

AlphaVision™ X X Back of sign

Director™
Wood X X X

Underneath bottom 
back panel

Aluminum X X Back of sign

PPD™ X Back of sign

NOTE 1: The shaded areas above indicate where the end-of-line (EOL) termination should be. 

NOTE 2: AlphaPremiere™ Series 9000 signs are terminated by dipswitch settings. Additionally, they have an RS232-only port and an RS485-only 
port if a standard configuration is used, and an Ethernet-only port and an RS485-only port if an Ethernet configuration is used.

http://www.ams-i.com/Pages/techdoc.htm:
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Appendix F—Alternate sign connections

There are ways to connects signs other than the standard PC-to-sign and sign-to-sign configurations.

NOTE: Be aware that, on some signs, an internal jumper must be set to either RS232 or RS485 
depending on the cabling the sign is using. See “Appendix D—Setting the RS232/RS485 
jumper” on page 49. Also, some signs may need to be terminated depending upon which type 
of network and the number of signs you are using. See “Appendix B—End-of-line 
termination” on page 46 for additional information.

Multiple signs without a PC
Use this setup when you want to connect multiple signs without using a PC. In this situation, an 

infrared Remote Control keyboard or an infrared Message Loader, instead of a PC, is used to send 
messages to a sign. See “Appendix A—Related documentation” on page 45 for more information on these 
items. 

Although this configuration is not as flexible or as powerful as using a PC to send and schedule 
messages, the Remote Control or Message Loader is adequate for sending a limited number of messages to 
a group of signs.

Item Part # Description

A 1088-9107
End-of-line (EOL) terminator (Must be plugged into the RS232 or TTL plug 
on the first and the last sign.)

B — Ferrite (ferrite end towards sign)

C
1088-8624 8-foot RS485 cable
1088-8636 1-foot RS485 cable

D 4331-0602 Modular Network Adapter
E 1088-8002 1000-foot RS485 shielded plenum cable
F 1072-1111 Infrared Remote Control keyboard
G 1071-1113 IR Message Loader

NOTE: Be sure to verify whether a jumper needs to be set on the sign you are using. See 
“Appendix D—Setting the RS232/RS485 jumper” on page 49.

Alpha sign

Y Z

S T U V W X

M N P Q RO

G H I J K L

A B C D E F

1 2 3 4 5 6

7 8 9 0

AUTO SPEED TIME DOT

ROLL WIPE SCROLL FLASH HOLD ROTATE

APPEND CURSOR SPECIAL FONT WIDTH COLOR

ON - OFF SOUND

INSERT BACK ADV DELETE

# ¢ $ % & *

< > = / + -

; : ” ’ , .

? !

PROGRAM RUN

SELECT

SPACE RETURN

SHIFT CAPS SHIFT

DATA VALID

1 2 3
MEMORY LOCATION

DATA BAT.LOW

TRANSMIT

MESSAGE
LOADER

A

To use a Remote Control or an IR 
Message Loader, point it at a sign’s 
infrared receiver window. 
Information on how messages are 
sent from one to sign another can be found in the 
manuals for the Remote Control and IR Message 
loader. See “Appendix A—Related documentation” on 
page 45.

A

To sign’s RS485 port

NOTE: To use a Personal Priority 
Display™ at the end of a network of 
signs, see “Appendix B—End-of-
line termination” on page 46.

Alpha sign

Alpha sign

To sign’s RS485 port

To sign’s RS485 port

B

B

C

C

D

D

E

F G
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Back-to-back wiring
Back-to-back wiring is the easiest way to network two signs together:

Item Part # Description
A 1088-8626 8-foot RS485 back-to-back cable

Alpha sign
RS-485  OUT

RS-485  IN

RS-485  IN

RS-232  IN

OR

OR

WARNING-NOT A
TELEPHONE
CONNECTION.A Connect each end of the cable 

to the RS-485 OUT/RS-485 IN 
plug on each sign.

NOTE: NEVER connect each 
end of the cable to the RS485 
IN/RS232 IN plugs on each 
sign as this may damage the 
signs.

Alpha sign

RS-485  OUT

RS-485  IN

RS-485  IN

RS-232  IN

OR

OR

WARNING-NOT A
TELEPHONE
CONNECTION.
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Alpha® Serial Clocks
The Alpha® Serial Clock displays the time in either 12-hour or 24-hour mode using a 4-inch LED 

display. It can be used all by itself or networked with other Alpha® clocks or signs. In a network, a clock 
behaves like an Alpha® sign in that it is used to synchronize all other clocks. In this case, the time is 
synchronized instead of a message. Also, just like an Alpha® sign, a clock must be terminated when it is 
the last device on a network.

Used by itself, an Alpha® Serial Clock should be set to Master Mode. In a network composed of all 
Alpha® Serial Clocks, one clock should be set to Master Mode and the other clocks set to Slave Mode. In a 
network with a PC that is connected to Alpha® clocks and signs, all the clocks should be set to Slave 
Mode. For more information on using the Alpha® Serial Clock, see ALPHA Serial Clock for Networked 
& Synchronized Timing Applications (pn 9703-3006).

NETWORK OF ALL CLOCKS

Item Part # Description

A 1088-9107
End-of-line (EOL) terminator (Must be plugged into the left—as you face the 
back of the clock—RJ11 port.)

B — Ferrite (ferrite end towards clock)

C
1088-8624 8-foot RS485 cable
1088-8636 1-foot RS485 cable

D 4331-0602 Modular Network Adapter
E 1088-8002 1000-foot RS485 shielded plenum cable

ALPHA HOUR MINUTE

A

A

To right port

To right port

To right port

B C D

E

ALPHA HOUR MINUTE

ALPHA HOUR MINUTE

ALPHA HOUR MINUTE

Alpha® Serial Clocks

To right port

B C D
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NETWORK OF CLOCKS ATTACHED TO A PC

Item Part # Description

A 1088-9107
End-of-line (EOL) terminator (Must be plugged into the left—as you face the back of the 
clock—RJ11 port.)

B — Ferrite (ferrite end towards clock)

C
1088-8624 8-foot RS485 cable
1088-8636 1-foot RS485 cable

D 4331-0602 Modular Network Adapter
E 1088-8002 1000-foot RS485 shielded plenum cable

F 1088-1111
Converter Box III with a Converter Box III AC Adapter:

pn 4011-1201 (120 volt)
pn 4011-4201 (230 volt)

G 1088-8634 Type A9 RS232 cable (connects Converter Box III to PC RS232 port)
H — DB25-to-DB9 adapter (if PC has a 9-pin RS232 port)

NOTE:The information below the dotted line is the hardware to be added when you want the Converter Box III in the 
middle of the network. In this situation, the Converter Box III must be set to Unterminated.

ALPHA HOUR MINUTE

A

To right port

To right port

To right port
B D

ALPHA HOUR MINUTE

ALPHA HOUR MINUTE

Alpha® Serial Clocks

B C D

C

Set switch to 
Terminated

To PC’s 
RS232 port

PC running 
messaging 
software

To RS485
connector

E

F G
H

B
To right port

To right port

A C D
E

(See NOTE below)

To RS485
connector on

ALPHA HOUR MINUTE

ALPHA HOUR MINUTE

Alpha® Serial Clocks

Converter Box III
(Set switch to
Unterminated.)
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NETWORK OF CLOCKS AND SIGNS

Item Part # Description

A 1088-9107
End-of-line (EOL) terminator (Must be plugged into the left—as you face the back of the 
clock—RJ11 phone jack.)

B — Ferrite (ferrite end towards clock)

C
1088-8624 8-foot RS485 cable
1088-8636 1-foot RS485 cable

D 4331-0602 Modular Network Adapter
E 1088-8002 1000-foot RS485 shielded plenum cable

F 1088-1111
Converter Box III with a Converter Box III AC Adapter:

pn 4011-1201 (120 volt)
pn 4011-4201 (230 volt)

G 1088-8634 Type A9 RS232 cable (connects Converter Box III to PC RS232 port)
H — DB25-to-DB9 adapter (if PC has a 9-pin RS232 port)

NOTE:The information below the dotted line is the hardware to be added when you want the Converter Box III in the 
middle of the network. In this situation, the Converter Box III must be set to Unterminated.

ALPHA HOUR MINUTE

Alpha sign

A

To right phone jack

To sign’s RS485 port

To right phone jack
B D

ALPHA HOUR MINUTE

Alpha® Serial Clock

B C D

C

Set switch to 
Terminated

To PC’s 
RS232 port

PC running 
messaging 
software

To RS485
connector

E

F G
H

BTo sign’s RS485 
port

To sign’s RS485 
port

A C D
E

(See NOTE below)

To RS485
connector on

Alpha sign

Alpha sign

Alpha® Serial Clock

Optional

Converter Box III
(Set switch to 
Unterminated.)
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Appendix G—Modular Network Adapter to Converter Box III wiring

Special wiring is needed to connect the Modular Network Adapter and the Converter Box III:

Item Part # Description
A — Ferrite (ferrite end towards sign)

B
1088-8624 8-foot RS485 cable
1088-8636 1-foot RS485 cable

C 4331-0602 Modular Network Adapter
D 1088-8002 1000-foot RS485 shielded plenum cable

E 1088-1111
Converter Box III with a Converter Box III AC Adapter:

pn 4011-1201 (120 volt)
pn 4011-4201 (230 volt)

W
H

BL

BR YL G
N

O
R

BK R
D

SH
IE

LD
 W

IR
E

BL
AC

K 
W

IR
E 

(+
)

R
ED

 W
IR

E 
(-)

SH
IE

LD
 W

IR
E

BL
AC

K 
W

IR
E 

(+
)

R
ED

 W
IR

E 
(-)

B

C

D

To next Modular Network Adapter
(if necessary)

Connect RED wire from RS485 cable to YL screw.
Connect BLACK wire from RS485 cable to BK screw.
Connect SHIELD wire from RS485 cable to RD screw.

NOTE: If the Modular Network Adapter is connected to a 
Personal Priority Display (PPD) sign, then connect 
the two SHIELD wires together from each RS485 
cable. However, do NOT connect these two wires 
to the SHIELD screw.

E

A
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Appendix H—Assigning an IP address to a serial server

For messages to be sent to a specific sign on the network, each serial server must have a unique IP 
address associated with it. There are several methods for assigning an IP address that can be used 
depending on various circumstances. For some of these methods, installation of the serial server hardware 
must be done while assigning the IP address. For other methods, the IP address can be assigned after the 
serial server hardware is installed.

To assign an IP address, you will need to know two numbers:

• The IP address to be assigned to each serial server, either the Alpha® Ethernet Adapter, MSS100, 
or MSS485. The specific address is usually designated by an IS network administrator.

• The hardware address of the serial server. This is found on a label on the back of the server.

Methods 1–5 for assigning an IP address are listed in order from the most simple and most often used 
to the least often used. Method 6 should only be used when setting the address of an AlphaPremiere™ 
9000 Series sign because a different serial server, called a CoBox card, sits inside this sign. The Cobox card 
has its own software for assigning IP addresses.

Method 1: EZWebCon

INSTALLING EZWEBCON SOFTWARE

You can get the latest version of EZWebCon for your network platform from either the Alpha® 

Ethernet Adapter CD or the Lantronix CD, or from the Lantronix Internet site (www.lantronix.com). Just 
download it to an empty directory on your PC. The following instructions use version 2.0/1 of 
EZWebCon, which may differ from the version you have. 

1. Double-click ezwebcon.exe in the downloaded files.

2. The EZWebCon application opens and installs itself on your PC.

CONNECTING THE SERIAL SERVER TO THE SIGN AND THE NETWORK

3. Connect a TCP/IP cable to an active port and to the serial server according to the information for 
your specific serial server in the sign-to-sign interfaces section beginning on page 22.

4. Connect the appropriate power supply to the serial server. For an Alpha® Ethernet Adapter, this 
will be the sign with its power cable plugged into an outlet. For a Lantronix serial server, this will 
be its own power cable.

RS232 cable

Serial server and 

TCP/IP cable

specific connections
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5. Check the LED lights on the serial server:

– The power light should be solid green, indicating it is properly powered.
– The link light should be solid green, indicating a valid network connection.
– The activity light should be blinking green, indicating normal operation.

USING EZWEBCON SOFTWARE TO ASSIGN THE IP ADDRESS

6. Open the EZWebCon software. The main window appears:

7. Select Action>Assign IP Address in the main window. 

8. The Assign IP Address to Server window appears. Complete the information as follows:

9. Click OK.

This always begin with
00-80-a3. It is also case sensitive 
and must be in lowercase letters.
You do not need to type dashes.

Type both the numbers and
decimal points.

This line should be grayed out
and the None box checked.

This line should contain zeros, 
or you can set it as needed 

This box should be checked.

for your system.
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10. Reboot the serial server if prompted to do so. 

11. Do one or more of the following:

– If the serial server already has an IP address assigned to it and you’re assigning the same one, 
EZWebCon will notify you. Click OK to continue. 

– If the serial server already has an IP address assigned to it and you’re assigning a different 
one, EZWebCon will ask whether you really want to assign the new address. Click Yes to 
continue.

– If the serial server does not have an existing IP address, EZWebCon will notify you that it will 
assign the IP address. Click OK to continue.

USING EZWEBCON SOFTWARE TO DETECT SERIAL SERVERS AND IP ADDRESSES ON THE NETWORK (OPTIONAL)

12. Open the EZWebCon software. The main window appears:

13. Click File>Browse Network to search for existing servers on the network.
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14. When the Browse Network window appears, it will show IP addresses of existing serial servers on 
the network, including the IP address just assigned to this serial server. (To print, press Print 
Screen on your keyboard and then paste into a drawing or word processing application.) 

NOTE: If the IP address you just assigned does not appear, you can ping the serial server as 
described in the section for “Method 2: DOS/ARP command”. If the IP address still does 
not appear, you must either assign an IP address to the serial server using a different 
method or contact IS personnel with the hardware address on the back of the serial server. 
IS can then use network management software to locate the IP address.

NOTE: It may be a good idea to write the IP address directly on the serial server.

15. Click Cancel and close EZWebCon.

Method 2: DOS/ARP command

In a DOS window in Microsoft® Windows 95 and Windows NT, the arp command is a simple way to 
assign an IP address when none has been previously assigned. The arp command is used here in 
conjunction with the ping command. The ping command is used to test the connection with the serial 
server and to determine whether the new IP address has taken effect.

NOTE: The arp command will not work if any IP address has ever been assigned to the given 
hardware address. The arp command will not replace an existing IP address with another IP 
address. You can use Telnet to change or delete an existing IP address. Refer to “Method 3: 
Telnet” on page 64.

OBTAINING NEW IP ADDRESS(ES)

1. Obtain a valid IP address for each serial server. This is usually assigned by an IS network 
administrator.



Networking Alpha® Signs

62 Appendix

CONNECTING THE SERIAL SERVER TO THE SIGN AND THE NETWORK

2. Connect the serial server according to the information for your specific adapter in the sign-to-sign 
interfaces section starting on page 22.

NOTE: Do not connect the power cable to the sign at this time.

SETTING UP DOS COMMANDS FOR ASSIGNING AN IP ADDRESS

3. Open a DOS window on the PC by selecting Start > Programs > MS-DOS Prompt.

4. Type “ping –t n.n.n.n” (where n.n.n.n is the IP address to be assigned to the serial server) and press 
Enter.

NOTE: This will continuously ping this IP address, allowing you to monitor exactly when 
communication to the device is established. You can stop the execution of this ping 
command by pressing Ctrl+C.

5. Open another DOS window by selecting Start > Programs > MS-DOS Prompt a second time.

6. Type “arp –s n.n.n.n 00-80-a3-x-x-x” (where n.n.n.n is the IP address of the serial server and 
00-80-a3-x-x-x is the hardware address of serial server), but do not press Enter. You must first 
complete the next step to power up the unit. This arp command will be executed in step 9. 

APPLYING POWER TO THE SERIAL SERVER AND TO THE SIGN

7. Connect the appropriate power supply to the serial server. For an Alpha® Ethernet Adapter, this 
will be the sign with its power cable plugged into an outlet. For a Lantronix serial server, this will 
be its own power cable.

8. Wait 30 seconds or until the activity light turns off and on only every two seconds. Both the sign 
and the serial server are now powered up and connected to the network.

RS232 cable

Serial server and 

TCP/IP cable

specific connections
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ASSIGNING THE IP ADDRESS

9. Press Enter at the DOS window with the “arp –s n.n.n.n 00-80-a3-x-x-x” command to actually 
assign the IP address.

NOTE: Once the serial server is initially powered up, you have only two minutes to assign it an IP 
address. After two minutes, either an alternate method must be used or the serial server 
must be rebooted by removing and reapplying power to it.

10. Watch the DOS window with the ping command to determine when communication has been 
established. A “Reply from” response will appear in the window when this happens.

11. In the DOS window with the ping command, stop the ping command by pressing Ctrl+C.

NOTE: The serial server will not save the learned IP address permanently. The time it is saved 
may vary depending on how your network is set up. This arp and ping procedure is 
intended as a temporary measure to allow EZWebCon to communicate with the serial 
server, or allow an administrator to Telnet into the serial server. Once logged in, the 
administrator can enter the “Change IP address” command to make the address 
permanent. See also “Reserving an IP address” on page 67 for instructions on determining 
and reserving an IP address.
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Method 3: Telnet

Telnet is used to program a hardware device for parameters such as baud rate, stop bits, parity, and 
particularly IP address. Telnet can be used to reassign an IP address directly when it has already been 
assigned an address by other means. 

CONNECTING THE SERIAL SERVER TO THE SIGN AND THE NETWORK

1. Connect the serial server according to the information for your specific adapter in the sign-to-sign 
interfaces section starting on page 22.

2. Connect the appropriate power supply to the serial server. For an Alpha® Ethernet Adapter, this 
will be the sign. For a Lantronix serial server, this will be its own power cable.

3. Check the LED lights on the serial server:

– The power light should be solid green, indicating it is properly powered.
– The link light should be solid green, indicating a valid network connection.
– The activity light should be blinking green, indicating normal operation.

STARTING TELNET

Telnet is fully functional on all PCs. To use Telnet, click Start > Run, and type “Telnet.” A generic 
window for Telnet will appear. You can also open a Telnet window for a specific serial server by clicking 
Start > Run and typing “Telnet n.n.n.n” (where n.n.n.n is the currently-assigned IP address of the serial 
server).

CHANGING AN IP ADDRESS

4. (Note: Skip this step if you opened a Telnet window for a specific serial server.) From the Connect 
menu, select Remote System and then, in the Connect window, type the IP address of the serial 
server in the Host Name line. Use “telnet” for the Port and “vt100” for the TermType.

RS232 cable

Serial server and 

TCP/IP cable

specific connections
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5. Type a user name and press Enter. It doesn’t matter what you type here, except that it must be 
different from that used by any other Telnet user on the network.

6. The “show server” command can provide confirmation that you’ve accessed the correct serial 
server and also provide statistics about that serial server.

7. Type “set priv”. Press Enter and then type the password. Press Enter again. The default password 
is “system.”
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8. You now have access to the Super User level of authority. This is required to set the IP address. 

9. To assign a new IP address, type “change ipaddr n.n.n.n” (where n.n.n.n is the new IP address).

10. Reboot the serial server by typing “i d 0” with spaces between the characters. (The last character is 
a zero.)

11. Because the serial server will no longer be at the same address as when you connected to it using 
Telnet, Telnet officially logs you out of that connection.

12. You then get this notification. 

13. After clicking OK, and after the serial server completes the reboot, you can connect to the server. 
You can also exit Telnet and send messages.
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Method 4: DHCP

Dynamic Host Configuration Protocol (DHCP) allows a device to use a dynamic IP address assigned 
at boot time from an available pool of addresses. With this method, you do not need to set the IP address 
in the hardware itself.

The serial server is shipped with DHCP disabled. However, if DHCP ever becomes enabled (such as 
after resetting the server) and if your network uses Dynamic Host Configuration Protocol (DHCP), then 
when the serial server is re-connected to the network and powered up, DHCP will automatically assign a 
dynamic IP address to the serial server. If you want to accept this assigned IP address and don’t need to 
reassign another chosen address, you will still need to review the instructions below to determine and 
reserve an IP address.

RESERVING AN IP ADDRESS

To allow you to send messages to the correct IP address, a system/network administrator must use 
the DHCP Manager (or similar) application to locate the serial server by its hardware address. The 
dynamic IP address is associated with the hardware address. This identification process can be involved 
on large networks.

A system/network administrator can use the system/networking DHCP Manager application to set 
the dynamically-assigned address to a permanent lease. This will reserve the IP address as a static address 
for the particular hardware address. If you do not reserve the IP address, periodically DHCP will 
automatically reassign a new dynamic—and typically different—IP address to the serial server. The result 
is that messages will not be delivered to the serial server.

RESETTING DHCP TO DISABLED

1. Follow steps 1 through 8 in Method 3: Telnet to start Telnet.

2. Type “change dhcp disabled” to disable DHCP.

3. Select Exit from the Connect menu to exit Telnet.
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Method 5: HyperTerminal

HyperTerminal may be used when you cannot access the serial server from the network. In this case, 
you will need to program the device directly using HyperTerminal and a null DB25F- or DB9F-to-DB25F 
serial cable (not supplied) from the PC to the server. (For an Alpha® Ethernet Adapter, however, you will 
need to split out two wires to connect the MSS device to an external power supply.) You will also need to 
use communication settings of 9600 baud, 8N1, and flow control set to either XON/XOFF or 
HARDWARE. For assistance, call Technical Support at Adaptive™ Micro Systems.

NOTE: HyperTerminal is fully functional on all PCs, but you may need to install it with the Add/
Remove Programs icon in the Control Panel.

Method 6: Setting an AlphaPremiere™ 9000 Series sign IP address

Before you begin using an AlphaPremiere® sign on an Ethernet network, you must assign it a unique 
TCP/IP address. The Alpha® Ethernet option inside the sign is shipped with a default address of 
010.11.11.1. The following instructions use version 2.0 of the DST configuration utility, which may differ 
from the version you have.

1. Write down the 6-digit Ethernet address found on the Ethernet option label on the back of the 
sign.

2. Using the Configuration Utility software supplied with the sign, select Tools > Assign IP:

Ethernet 
address

232/AUX

RXD
TXD

RS232/AUX

RS485

4
2

Spkr
Out
Sign
Reset

RS485

6
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3. Enter a unique IP address in the Enter IP address to assign line.

4. Enter the 6-digit Ethernet address you wrote down in step 1 in the Enter the Hardware or Ethernet 
Address line and click Set IP Address.

5. Select Tools>Ping Device. Re-enter the sign’s IP address in the Enter IP Address line and click Ping to 
verify the IP address you just assigned works. If a reply from the sign is not received, repeat steps 
1–4.

Resetting a serial server

There may be times when you need to reset the serial server to its default factory settings. These 
default settings include setting DHCP to enabled.

1. Remove power from the adapter, either the cable to the sign (Alpha® Ethernet Adapter) or its 
power cable (MSS100 or MSS485).

2. Using the point of a pen or a similar object, press and hold the reset button on the serial server and 
then reapply power to the sign. Continue to hold the reset button for 20 seconds after reapplying 
power.
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Appendix I—Setting up messaging software for TCP/IP networking

A serial server receives a message from one PC over a network and sends it on to a sign. This is in 
conjunction with any software that can use the TCP/IP protocol. AlphaNET plus for Windows (version 1.3 
or later), AlphaNET 2.0 for Windows, and Smart Alec® (version 3.0 or later) are TCP/IP-compatible.

Creating the device in the software

You must create a device that will use a serial server and TCP/IP and set the port number to 3001. The 
AlphaNET 2.0 screen for TCP/IP will look like this:

For Smart Alec® 3.0, the screen looks like this:

After setting up a TCP/IP device and a sign using that device, you can send messages to this sign as 
you normally would.

This must be checked.

This must be “3001”.

This must be “terminal server” 
since Smart Alec® refers to any 
serial server as terminal.

This must be “3001”.

Type the IP address of 
the terminal server.
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Installing and selecting Redirector settings

Lantronix Redirector software is needed for sending messages with Alpha® Messaging Software or 
BetaBrite® Messaging Software over a TCP/IP network to one or more signs.

Lantronix Redirector software is used to redirect messages normally sent through a PC COM port to a 
sign. Redirector associates the PC COM port with a network IP address for a serial server. The serial 
server, in turn, is connected to the sign and sends the message on to the sign. In other words, Redirector 
intercepts messages going to the COM port and sends them over the network to the serial server’s serial 
port and to the sign. 

NOTE: The COM port you choose cannot be in use by any other device. For example, an internal 
modem. To determine which ports are in use, click Start > Settings > Control Panel and select 
System. Click the Device Manager tab. In the Ports directory, determine the COM ports 
currently in use. Redirector allows up to 40 logical COM ports to be redirected. You can 
redirect any except those currently in use. However, Alpha® Messaging Software and 
BetaBrite® Messaging software only recognize COM ports 1 through 4.

The following instructions use version 2.1/1 of the Redirector software, which may differ from the 
version you have.

INSTALLING REDIRECTOR

You can get the latest version of Redirector for your network platform from either the Alpha® Ethernet 
Adapter CD or the Lantronix CD, or from the Lantronix Internet site (www.lantronix.com). Just download 
it to an empty folder on your PC.

DIRECTING A COM PORT TO A SERIAL SERVER WITH REDIRECTOR SOFTWARE

1. Open the Redirector software. The main window appears:

2. Select the COM port that you want to redirect from the Redirect To drop-down menu. 
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3. Click Add IP. In the IP Service Setup window, enter the IP address of the serial server that 
EZWebCon detected in the Host line. In the TCPPort line, enter “3001,” a valid number used for 
any serial server. Click OK.

4. Click Save from Redirector’s main window.

5. When the Config Info window appears, click OK and then close Redirector.

6. If prompted, reboot the computer. You should now be able to access the sign using Alpha® 
Messaging Software or BetaBrite® Messaging Software via the network.

Setting serial servers for Gateway Messaging Software

To use Gateway Messaging Software to send messages over a TCP/IP network, you must use an 
MSS485 as a local/host serial server to send messages all at once to one or more signs, each with a remote 
serial server attached.

In this mode, you set one MSS485 as the local/host device. When setting up the MSS485, you assign it 
a fixed list of up to 12 IP addresses of serial servers. You set up each receiving serial server as a remote 
device. Then you can use the local/host device to send messages at one time to all the remote devices in 
the fixed list. 

Setting up the MSS485 to act as a local device

You must program the MSS485 devices with IP addresses before setting them up. The firmware 
version of the MSS485 must be B3.5/905 (dated 990518) or higher.

1. Select Start > Run. Type “Telnet n.n.n.n” where n.n.n.n is the assigned IP address for the MSS485. 
Click OK.
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2. Type a user name and press Enter. It doesn’t matter what you type here, except that it must be 
different from that used by any other Telnet user on the network.

3. Type “set priv.” Press Enter. Then type the password. Press Enter again. The default password is 
“system.”

4. Type “change flow control none.” Press Enter. 

5. Type “change charsize 7.” Press Enter. 

6. Type “change stopbits 2.” Press Enter. 

7. Type “change parity even.” Press Enter. 

8. Type “change access local.” Press Enter. 

9. Type “change dedicated hostlist.” Press Enter. 
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10. Type “host add tcp n.n.n.n:3001T” where n.n.n.n is the IP address of a serial server to be used in 
remote mode. Press Enter. Do this for each remote serial server to receive messages from the local 
MSS485. 

11. Type “change autostart enable.” Press Enter. 

12. Type “show hostlist.” Press Enter. This will show the list of the remote serial server IP addresses 
you entered. 

13. Type “show port.” Press Enter. This will show the current settings of the port. 

There is a maximum of twelve (12) IP addresses that 
can receive messages from a local MSS485. However, 
if a remote serial server is an MSS485, there can be 
multiple signs receiving messages through that serial 
server.
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SETTING UP SERIAL SERVERS TO ACT AS REMOTE DEVICES

You must program all serial servers with IP addresses before setting them up in remote mode. The 
firmware version of any serial server must be B3.5/905 (dated 990518) or higher. 

1. Select Start > Run. Type “Telnet n.n.n.n” where n.n.n.n is the assigned IP address for a remote 
serial server. Click OK.

2. Type a user name and press Enter. It doesn’t matter what you type here, except that it must be 
different from that used by any other Telnet user on the network.

3. Type “set priv.” Press Enter. Then type the password. Press Enter again.The default password is 
“system.”

4. Type “change flow control none.” Press Enter. 

5. Type “change charsize 7.” Press Enter. 
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6. Type “change stopbits 2.” Press Enter. 

7. Type “change parity even.” Press Enter. 

8. Type “change access remote.” Press Enter. 

9. Type “show port.” Press Enter to show the current settings of the port. 

10. Repeat step 1 through 9 for all serial servers to be used in remote mode.

RESETTING AND CHECKING ALL DEVICES

1. Remove power from all the remote serial servers and re-apply power.

2. Remove power from all the local MSS485 devices and re-apply power.

3. Select Start > Run. Type “Telnet n.n.n.n” where n.n.n.n is the assigned IP address for the local 
MSS485 devices. Click OK.

4. Enter a user name and password.
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5. Type “show port.” Press Enter. This will show the current settings of the port. The Sessions number 
indicates how many remote serial servers you set up for the local MSS485 to send messages. 
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Glossary

AC

Alternating Current. An electronic current that reverses direction in a circuit at regular intervals, 
usually used for higher voltages.

ACK

Acknowledgment. An ASCII or EBCDIC code indicating that a message has been received 
correctly.

ActiveX

Alpha® Marquee ActiveX® control is a development tool designed to ease communication with 
an Alpha® Marquee display. Product of Adaptive®.

adapter

A piece of hardware installed on a computer or electrical component connecting it to other 
hardware. Converts one format to another, either physical (type of plug), electrical 
(configuration of wiring), or electronic (computer/monitor interface).

address

An identifier assigned to networks, stations, and other devices so that each device can be 
separately designed to receive and reply to messages. See also serial address.

administrator

The person who sets up a server, creates user login accounts and passwords, creates groups, sets 
security, and maintains the server.

Alpha® protocol

The proprietary internal instruction language used by Alpha®, AlphaVision™, BetaBrite®, 
AlphaEclipse™, and Solar™ signs. Also known as “EZ95.” 

AMS

Adaptive Micro Systems, Inc.
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AMS(E)

Adaptive Micro Systems, Europe.

AMS(I)

Adaptive Micro Systems, International. (Refers to Milwaukee location.)

AMS(M)

Adaptive Micro Systems, Malaysia.

animation

A sequence of graphics designed to be shown together to give the illusion of motion, such as a 
walking shoe, a moving boat, or a light turning off and on. 

ANSI

American National Standards Institute. A nonprofit organization in the United States that 
defines standards in many industries. For example, how safety symbols appear in 
documentation. It is supported by over 1,000 trade organizations, professional societies, and 
companies, and affiliated with the Consultative Committee for International Telegraphy and 
Telephony (CCITT) and the International Standards Organization (ISO).

apparatus

A complex device or machine consisting of the enclosure, the enclosed equipment, and the 
protruding accessories, designed for a specific purpose. 

AppleTalk

The Apple Computer suite of protocols that allows the hardware and software on an AppleTalk 
network to interact and route data.

AppleTalk network

A collection of connected, individually controlled computers, printers, and other devices, 
together with the hardware and AppleTalk software used to link them.

application

A software program with which a user can create, authorize, or change data. Can generally be 
accessed from a menu or toolbar.
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AR

Access Rate. Actual data access rate measured in bits per second. 

ASCII

American Standard Code for Information Interchange. A set of characters using an 8-bit code for 
data transfer adopted by ANSI to ensure compatibility among data devices.

back end

A device (such as a server or software program) that provides services to a front end (a software 
application). See also front end.

baseband

Characteristic of a network technology where only one carrier frequency is used, like Ethernet.

battery backup

Battery-backed up memory. If a sign is turned off, unplugged, or power is inadvertently lost, the 
messages, graphics, and time settings stored in the sign’s memory are not lost. When the sign is 
plugged in again, the messages, graphics, and time that were in memory are still available. Some 
signs use a battery; some use a capacitor.

baud

The speed at which data bits are transmitted and received, usually measured in bits per second. 
For example, 9600 baud is equal to 9600 bits per second.

binary

A numbering system comprised of bits, strings of ones and zeros. See also bit.

bit

Binary digit used in the binary numbering system. Can be 0 or 1.

boot

To plug in, turn on, or otherwise start a computer, sign or machine.
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boot code

Firmware used for power-up on a display sign’s controller board.

bridge

A device that connects two or more physical networks, forwarding frames between networks 
based on information in the datalink header. Because a bridge operates at the datalink layer, it is 
transparent to the network layer protocols.

brightness

The output intensity of an LED measured in millicandela (mcd). The higher the number, the 
brighter the intensity. See also luminance and wavelength.

broadcast

A transmission method by which all devices/nodes on a network receive a copy of any message 
that is designed for broadcast. For example, when a message is broadcast, each sign on that 
network displays the message.

browser

A GUI-based software application used to access hypertext documents and other services on the 
World Wide Web or Internet. See also GUI.

buffer

Stores chunks of data in transit until they can be processed.

byte

Made up of 8 bits. See also bit.

cable connectivity

A cable connection between the serial port of a computer and a sign. This is the simplest type of 
connection. Also referred to as a wired or serial connection.

cabling

The wiring that connects pieces of a network together. RS232 and RS485 are types of cabling used 
with Adaptive® displays.
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CE

Compliance European. The agency that sets the standards LED signs must meet if they are to be 
sold in Europe. International only.

center-to-center spacing

The distance from the center of one pixel to the center of the next adjacent pixel. Useful in 
determining character height. Also known as pitch.

character

Any letter, number, punctuation mark, or other symbol used in text. A typical character is 7 
pixels high by 5 pixels wide, plus the spaces between characters and lines. 

character height

LED character height usually expressed in pixels. For example, 8-high.

character height-to-pitch relationship

Character height (rows) times the pitch equals the height of the characters. For example, for an 
Alpha® 215 sign, 7 rows times 0.3 inches is equal to 2.1 inches.

characters per line

Determined by the number of pixels across the sign and by the size of the character. A normal 
character is 5 pixels wide with one pixel space separating characters. Thus, an 80 column sign 
can display 13 characters (80/6= 13.3).

TIP: As you plan your sign requirements, write down the messages you intend to display on the 
sign. Count the characters in the words that you use most often. How many words you want to 
see at once determines the number of characters per line required by your application. If a word 
will not fit on the line, the word displays one character at a time or it starts a new line, depending 
on the display mode being used.

checksum

A numeric computation using the bits of a transmitted message, and the resulting value. The 
value is transmitted with the message, and the receiving device recalculates the checksum, then 
compares it to the received value to detect transmission errors.
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chip

A small device found on the microboard of an LED sign. Contains a program (RAM or EPROM, 
for example) that runs the sign.

circuit

Any path that can carry an electrical current.

client

Software program or node that requests services from a server.

clusters

Multiple LEDs assembled in groups that together form one bright pixel point when lit. The LEDs 
are connected to a molded cup which is then filled with clear epoxy to hold the LED in place. 
Clusters may contain one color LED or, in a multi-color application, a combination of different 
colors.

CM

Character Matrix. Displays characters only (not graphics) in discrete blocks of LEDs.

coaxial cable

A type of cable that uses two conductors: a central, solid wire core surrounded by insulation and, 
surrounding that, a braided wire conductor sheath. 

code

Specific firmware or software containing instructions for a computer or sign.
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color

Adds interest and contrast over a monochrome, red-only sign. For simple informational signs, 
red is often sufficient. The green and amber colors are considered softer colors and may be more 
appropriate for some environments. Color signs can be 3 color, (red, amber, and green), 9 color, 
(additional shades of red, amber, and green), 256 color (usually RGB or CMYK), 262,000, or 
4,000,000 for full color displays. Some signs allow you to set the color of the background or the 
foreground. In a red-only sign model, this would allow red text on a black background or black 
text on a red background. In a multi color sign, you could have a variety of text colors and a 
variety of background colors. 

Note: Certain colors and color combinations are more readable and visible than others. The 
elaborate combinations generally work better at night. In bright sunlight, bright colors on a black 
background are the easiest to read. 

COM port

An abbreviation for communications port. A data pathway, generally referred to as a serial port, 
that connects to a communication device.

controller board

The circuit board in an LED sign that controls the entire sign, such as which dots turn on. Sends 
information to the driver boards. Also known as micro board or micro controller board.

converter box

Changes RS232 signals into RS485 signals. 

CPU

Central Processing Unit. The brains of a computer designed to run a group of instructions, such 
as adding numbers together, gathering information from memory, and so on.

CSA

Canadian Standards Association. The agency that tests LED signs, among other things, to make 
sure they are safe for use. An LED sign cannot be shipped to Canada without a CSA label.

data block module

An LED mounted on a circuit board and epoxied into a block module that contains a specific 
number of rows and columns of pixels.
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datagram

Logical grouping of information sent as a network layer. The primary bits of information on the 
Internet.

data rate

The speed at which data bits are transmitted and received, usually measured in bits per second. 
See also baud.

date of manufacture

The month, day, and year the sign is made. Adaptive Micro Systems uses a date code of YYMM, 
where April 2001 would read 0104.

DC

Direct Current. A current that flows in one direction only, like that of a battery.

DDE

Dynamic Data Exchange. A form of communication in OS/2 and Windows® software, not as 
advanced as OLE. When two or more programs are supporting DDE and running 
simultaneously, they can exchange information and commands. 

density

Defined by the pixel diameter and center-to-center spacing of the character displayed. The closer 
the pixels are to each other, the higher the resolution of the character. Low resolution characters 
are designed for distance viewing. Also known as resolution.

destination address

Address of a network device that is receiving data. For example, the address in a message packet 
identifying which sign is to receive it.

destination node

In the Open Systems Interconnection (OSI) model, the nodes that represent the host computers at 
each end of a connection. In a packet-switching network, the node attached to the device that is 
receiving the data.
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device

Any hardware component attached to a computer system.

device driver

The software or firmware that translates operating system requests into a format that is 
recognizable by specific hardware, such as an adapter.

DHCP

Dynamic Host Configuration Protocol. A method of automatically assigning a TCP/IP address 
to a client.

digital display

An electronic sign that combines text and graphics to convey a fixed or changeable, moving or 
unmoving advertising or locational message. See also electronic display.

digital sign

An electronic sign that combines text and graphics to convey a fixed or changeable, moving or 
unmoving advertising or locational message. See also electronic display.

DIP switches

Switches are housed in a rectangular box on a circuit board and control specific features to 
whichever device they belong. The switches are binary, either on or off, and are often used in 
place of groups of jumpers.

display

An electronic sign that combines text and graphics to convey a fixed or changeable, moving or 
unmoving advertising or locational message. See also electronic display.

display array

Rows and columns. The number of dots or pixels vertically and horizontally in a sign. For 
example, 16 x 80 means that the sign has 16 dots vertically and 80 dots horizontally, for a total of 
1280. The characters and graphics of a message are formed by turning on or activating specific 
patterns of pixels within the display array.
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DLL

Dynamic Link Library. An OS/2 and Windows® software feature that allows executable code 
modules to be loaded on demand and linked to run time.

driver board

A circuit board in an LED sign that takes information from the micro board and uses it to turn an 
LED on or off. Display cubes are mounted, socketed, or soldered on a driver board.

drop test

A test done on each new product to determine whether its packaging material is sufficient for 
shipping. ETL is an example of a company that performs the test.

duplex adapter

Converts a single jack into a dual jack to allow two accessories to be connected at the same time.

EEPROM

Electronic Erasable Programmable Read Only Memory. A small device usually found inside the 
access door of an LED sign containing a program (firmware) that runs the sign, which can be 
written to over and over again.

electrical information

Input voltage, frequency, amperage, and watts.

electronic display

An electronic sign that combines text and graphics to convey a fixed or changeable, moving or 
unmoving advertising or locational message. The following terms are used interchangeably: 
ACD display, alphanumeric display, auditorium marquee, banner, banner board, communication 
center, communicator, digital display, digital sign, directional marquee, display, display board, 
electronic banner, electronic display, EMC (electronic message center), electronic sign, graphic 
display, hall marquee, LED display, LED sign, light board, marquee, message board, message 
center, message display, moving message display, moving message sign, news ticker, price 
changer, programmable sign, reader board, salescaster, scanvertiser, sign, silent radio, silent 
salesman, stock ticker, ticker, ticket marquee, time-temperature display, and zipper.

electronic sign

An electronic sign that combines text and graphics to convey a fixed or changeable, moving or 
unmoving advertising or locational message. See also electronic display. 
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EMC

Electronic Message Center. An electronic sign that combines text and graphics to convey a fixed 
or changeable, moving or unmoving advertising or locational message. See also electronic display.

enclosure

A case that provides protection to someone against contact with the enclosed equipment, and to 
protect the enclosed equipment from the elements. NEMA standards allow for many different 
types of enclosures, indoor and outdoor.

end node

The machine or unit (node) that serves as an originator or final destination of network traffic, but 
does not relay traffic originated by other nodes.

end-of-line terminator

Used to define the start and end of a network. Helps control electrical interference on the 
network and provide stable communication across a network.

EPROM

Erasable Programmable Read Only Memory. A small device usually found inside the access 
door of an LED sign containing a program (firmware) that runs the sign.

ERP

Enterprise Resource Planning. A billion dollar sales industry, of which Oracle is its largest 
company, for systems designed to coordinate database management for sales forecasts, order 
management, purchasing, product scheduling, inventory management, and other functions 
required to complete the manufacturing of a product.

ESD

Electrostatic Discharge. Discharge of stored static electricity that can damage electronic 
equipment and impair electrical circuitry, resulting in complete or intermittent failures.

Ethernet

Links devices (such as a group of display signs) on a network. Baseband LAN specification 
invented by Xerox Corporation and developed jointly by Xerox, Intel, and Digital Equipment 
Corporation. Ethernet networks use CSMA/CD and run over a variety of cable types at 10 Mbps 
(megabits per second). Newer versions of Ethernet, such as Fast Ethernet and Gigabit Ethernet, 
support data transfer rates of 100 Mbps and 1 gigabit (1,000 megabits) per second, respectively.
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Ethernet adapter

Device used to convert TCP/IP protocol to RS232/485.

Ethernet connectivity

An ethernet connection between a computer and a company’s local area network, supported by 
TCP/IP.

ETL

Edison Testing Laboratories. An agency that tests and certifies conformity to both domestic and 
international electrical standards. A product tested for safety by ETL has an ETL label.

FCC

Federal Communications Commission. Regulates radio frequency emissions from an interaction 
between electrical and communication devices. Domestic only.

field

One item of information about something, such as a name, action, or destination for a command.

firmware

Name used to describe the program stored on a chip. May be referred to as the operating system, 
but the terms are not always synonymous.

flash

A method of updating a fixed EPROM by sending the new firmware program from a PC to the 
EPROM. Eliminates the need to physically replace firmware chips.

flick

Multiple bitmapped images displayed one after another to give the illusion of movement.

flush mounting

A construction that has a minimal front projection when set into a recessed opening and secured 
to a flat surface. 
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Frame Relay

A method of communication that can go from ISDN speed to T1 speed in increments. It has a flat 
rate billing instead of a per time usage. It connects by using the telephone company's network. 
See also ISDN and T1.

front end

A software application that requests services from a device (such as a server or software 
program). See also back end.

FM

Full Matrix. Displays characters and graphics with no empty spaces between blocks of LEDs.

FUTS

First Unit to Ship.

Gateway

Product name for an Adaptive® interface from a PLC to a sign.

graphic

On a sign, a picture consisting of a pattern of pixels often displayed in one position, such as a 
company logo or an identifiable product (for example, a car, light, or shoe). Displays a single 
bitmapped image. 

Group

One or more sites in AlphaNet plus™ for Windows® or Smart Alec software.

GUI

Graphical User Interface. A program interface that takes advantage of the computer’s graphics 
capabilities to make the program easier to use. 

hazardous locations

Locations that contain enough hazardous materials to create an explosion, according to National 
Electrical Manufacturer’s Association (NEMA) standard.
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indoor character size

2” and 4” high characters are commonly used in most interior applications. In warehouses or 
manufacturing environments where signs are to be viewed from greater distances, 4" or 7" 
characters work best. 

indoor locations

Areas protected from exposure to the elements. Viewing distances are generally shorter.

industry automation

Any type of machine process in which a controller (PLC) contains data that will be used on an 
EMC or electronic display.

infrared

A form of radiation with a wavelength between 750 and 100,000 nanometers, which is above that 
of visible light and below that of microwaves. Infrared sensors are used in night-vision goggles 
and sensors. Infrared light can be used to send signals wirelessly back and forth between 
computing devices.

integrated circuit

A small device that performs various electronic tasks. Also known as a chip.

Internet

The collection of networks and gateways that use the TCP/IP suite of protocols. Written in 
lowercase, it is an abbreviation for internetwork.

Internet address

A 32-bit address assigned to hosts using TCP/IP.

IP

Internet Protocol. A TCP/IP protocol that provides datagram delivery of messages.

IP address

A 32-bit address assigned to hosts using TCP/IP.
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ISA

Industry Standard Architecture. Expansion slots and the associated circuits. Transfers 16 bits of 
data at a time between the add-in board plugged into the slot and the computer.

ISDN

Integrated Services Digital Network. An international communications standard for sending 
voice, video, and data over digital telephone lines or normal telephone wires at 64 Kbps (64,000 
bits per second) per line.

ISO

International Standards Organization. An international organization that establishes global 
standards for communication and information exchange, as well as for many other fields of 
commercial activity.

jumper

An electrical switch consisting of a number of pins and a connector that can be attached to the 
pins in a variety of ways. Different circuits are created by attaching the connector to different 
pins. Can also be a wire.

knockout

A portion of the wall of an enclosure that can be removed by a hammer, screwdriver, or pliers at 
the time of installation in order to provide a hole for the attachment of an auxiliary device, cable, 
or fitting. 

LAN

Local Area Network. A group of computers and other devices connected by a communications 
link that allows a device to interact with any other device on that network. The devices are in 
close proximity, hence the word local.

LAN connectivity

A LAN connection in which one or more displays signs are linked by Alpha® Ethernet Adapters 
or serial servers.
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LAWN

Local Area Wireless Network. A group of computers and other devices connected by a wireless 
communications link that allows a device to interact with any other device on that network. A 
transmitter attached to a PC broadcasts data to devices equipped with a data receiver. 
Transmission range is usually limited to a mile, hence the word local.

LED

Light Emitting Diode. A tiny chip of silicon made to produce light in a variety of colors, 
including red, green, yellow, and blue. A semiconductor diode that converts applied voltage to 
light as is used in digital displays. 

LED display

An electronic sign that combines text and graphics to convey a fixed or changeable, moving or 
unmoving advertising or locational message. See also electronic display.

LED sign

An electronic sign that combines text and graphics to convey a fixed or changeable, moving or 
unmoving advertising or locational message. See also electronic display.

line position

Where a message appears on a sign. Includes top, bottom, middle, and fill.

loopback

A diagnostic test in which a signal is transmitted across a medium while the sending device 
waits for its return.

luminance

A measure of brightness in millicandela (mcd). See also brightness and wavelength.

marquee

An electronic sign that combines text and graphics to convey a fixed or changeable, moving or 
unmoving advertising or locational message. See also electronic display.

medium

Physical environments through which transmission signals pass.
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MES

Manufacturing Execution Systems. The software that sits between ERP systems and the 
machines on the factory floor. It tracks and pulls together information in real time about the key 
areas of production: materials, equipment, personnel, work instructions/specifications, and 
facility conditions. It is the software that feeds the databases used to make decisions in the ERP 
systems.

message

A unique, unified set of information that can be saved or sent to a sign. Includes text, graphics, 
formatting, animation, time, date, temperature, and so on.

message center

An electronic sign that combines text and graphics to convey a fixed or changeable, moving or 
unmoving advertising or locational message. See also electronic display.

message display

An electronic sign that combines text and graphics to convey a fixed or changeable, moving or 
unmoving advertising or locational message. See also electronic display.

micro board

The circuit board in an LED sign that controls the events in a sign, such as which dots turn on. 
Sends information to the driver boards. Also known as controller board or micro controller 
board.

model number

Type of sign, size, and color capability.

modem

Translates digital signals to analog and back again for transmission through telephone wires, 
wireless transmitters, wireless paging services, or fiber optic cables. A contraction of modulate 
and demodulate.
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modem connectivity

A modem connection between the modem on a sending computer and a modem in or near a 
sign. When a message is sent, the software automatically dials the phone number of the modem 
in the sign. The telephone line can be a line provided by the phone company or an extension on 
an internal phone system. A modem connection is generally used when it is easier to get a phone 
line to the sign location than it is to pull a serial cable. Modem connectivity is also used when 
programming needs to be done remotely.

modes

Special effects that change the way text appears on a sign. For example, messages can move left 
or right, or the top line remains fixed while the bottom line moves.

modular network adapter

Used at Adaptive® to connect a sign to an RS485 network.

modules

Subassemblies produced to contain a specific number of rows and columns of pixels to simplify 
the assembly of larger signs and to permit more flexibility in the design and construction of 
signs. 

moving message display

An electronic sign that combines text and graphics to convey a fixed or changeable, moving or 
unmoving advertising or locational message. See also electronic display.

moving message sign

An electronic sign that combines text and graphics to convey a fixed or changeable, moving or 
unmoving advertising or locational message. See also electronic display.

multiplexing

The most common technique used in indoor displays to get the greatest range of brightness. A 
scheme that allows multiple signals to be transmitted at the same time across one physical 
channel. 

NAK

Negative Acknowledgment. An ASCII or EBCDIC code indicating that a message has not been 
received correctly.
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NEMA

National Electrical Manufacturing Association. Creates standards for enclosures for electrical 
devices. Domestic only. For Adaptive® users, NEMA standards for enclosures protect displays 
from dirt, dust, and oil in a factory setting.

network

A collection of interconnected, individually controlled devices, together with the hardware and 
software used to connect them.

network address

A unique network layer number that refers to a device residing on a network. 

node

An addressable entity on a network. The node acquires a unique 8-bit node number dynamically 
when it connects to the network. It tries that address and node number again when it next 
connects to the network. If the previous number is already in use, it tries again until a unique 
node address is found.

node address

A number acquired dynamically by each node when it connects to a network. A device’s node 
address is combined with the network number to form its unique network address.

non-ventilated

Provides no intentional circulation of external air through the enclosure. 

octet

A group of 8 binary digits operated on as a unit. Also called a byte or a character.

ODBC

Open Database Connectivity. A Microsoft® standard that allows databases created by various 
relational and non-relational database programs (such as dBase, Access, FoxPro, and Oracle) to 
be accessed by a common interface.

oil-resistant gaskets

Gaskets made of material that is resistant to oil or oil fumes. 
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OLE

Object Linking and Embedding. The interface that embeds an object created by one application 
into a document created by another, performs drag-and-drop transfers within or between 
applications, and so on. Any changes to the original object are automatically reflected in the 
document where it is embedded.

outdoor locations

Areas exposed to the elements. Viewing distances are generally longer.

PCB

Printed Circuit Board. The card type material of which micro boards and driver boards are 
made.

PING

Packet Internet Grouper. A program used to test the reachability of destinations by sending an 
Internet Control Message Protocol (ICMP) echo request and waiting for a reply.

pitch

The distance from the center of one pixel to the center of the next adjacent pixel. Also known as 
center-to-center spacing.

pixel

Picture element. The smallest element or spot that a screen or sign can display.

pixel diameter

Determines the size of a pixel. A pixel can be as small as a single .1" diameter LED. 

PLC

Programmable Logic Controller. Used in industrial environments to continually turn off various 
devices without fail using programmed logic (for example, traffic lights).

PN

Part Number. A unique number assigned to each product, document, brochure, and so on, and 
to many components.
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polling

Any procedure that sequentially and periodically contacts terminals in a network.

port

a) The hardware that allows a component to communicate with a peripheral, such as a parallel 
port. b) The logical point of contact between a LAN driver and a protocol that is bound to it. c) A 
unique server input/output address assigned to a local area network driver in NetWare 
software.

programming

The process of composing messages and graphics, and specifying the display modes, fonts, 
colors, and location of text and graphics on the display screen. 

protocol

A set of rules for transmitting data within a network or internetwork. Specifies the format, 
timing, and sequence in which the network transmits data. Common protocols include AFP, 
ALAP, RTMP, NCP, IPX.

reader board

An electronic sign that combines text and graphics to convey a fixed or changeable, moving or 
unmoving advertising or locational message. See also electronic display.

record

A collection of related fields, such as all the information about one display command.

repeater

Used to boost the electrical signal along very long networks.

resolution

The quality and clarity of text and graphics, defined by the pixel diameter and center-to-center 
spacing of the character displayed. The closer the pixels are to each other, the higher the 
resolution of the character. Low resolution characters are designed for distance viewing. Also 
known as density.
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rev

Revision.

RF transmitter

Radio frequency transmitter. Wireless device which sends a message from a network computer 
and modem to a data receiver.

routing

The transmission of a datagram from one node to another on the same or a different network. 
Refers to the paths that are chosen to transmit an IP datagram from its origin to its destination, 
based on the IP addresses contained in the datagram.

RS232

Uses serial communication, specifically RS232 protocol. Connects a sign directly to a computer. 
Limited to a distance of 50 feet and connects only one sign to one computer.

RS232/RS485 jumper

A set of three small prongs inside some signs with a connector that covers only two of the three 
prongs (jumper). Determines whether the sign is using RS232 or RS485 communication.

RS485

Uses parallel communication, specifically RS485 protocol. Connects multiple signs directly to a 
computer for distance longer than 50 feet. Requires a converter box.

RTC

Real-time Clock. A memory chip that allows a sign to retain accurate time while not powered. 
Runs from a battery.

serial

An RS232, RS485, or USB connection between a PC and one or more computers in a network.

serial address

An identifier assigned to networks, stations, and other devices so that each device can be 
separately designed to receive and reply to messages. See also address.
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serial number

Unique identification number for each sign or other product. Usually a consecutive sequence 
within a given model line.

server

A combination of controller software and mass storage devices that allows computer users to 
share common files and applications on a network.

sign

An electronic sign that combines text and graphics to convey a fixed or changeable, moving or 
unmoving advertising or locational message. See also electronic display.

Site

A collection of one or more signs in AlphaNet plus™ for Windows® software.

Smart Alec

Intelligent messaging system that delivers messages and real-time data from a variety of 
information systems to a variety of communication devices.

snippet

A block of text that is saved for repeated use in AlphaNet plus™ for Windows® software.

storage capacity

Ranges from 7,000 to 1,000,000 characters and more for message storage capacity (graphics 
require more), depending on the sign and the application.

string file

A sequence of data values, usually bytes, that represent variables. These variables may be 
updated independently of the rest of the message without affecting the rest of what is being 
displayed on the sign. 

surface mounting

Secured to and projected from a flat surface. Describes how components are mounted (soldered) 
to a PCB (printed circuit board). 
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T1

A dedicated phone connection supporting data rates of 1.544 Mbps (bits per second). A T1 line 
actually consists of 24 individual channels, each of which supports 64 Kbps. Each 64 Kbps 
channel can be configured to carry voice or data traffic. 

TCP

Transmission Control Protocol. The major transport protocol in the Internet suite of protocols, 
providing reliable, connection-oriented, full duplex streams. Uses IP for delivery.

TCP/IP

Transmission Control Protocol/Internet Protocol. A set of rules originally developed by the 
Department of Defense to link dissimilar computers across many kinds of networks.

Telnet

A protocol in the TCP/IP suite that governs character-oriented terminal traffic.

through hole

Hole in the casing of a sign through which wiring is brought to connect a device.

ticker

An electronic sign that combines text and graphics to convey a fixed or changeable, moving or 
unmoving advertising or locational message. Primarily used to display financial data. See also 
electronic display.

topology

The physical design or layout of network components (cables, stations, gateways, and hubs). 
Three basic interconnection topologies are star, ring, and bus networks. The flow of data differs 
in each topology.

transparent

A description of a function that operates without being evident to the user or software 
application.

tri-color

Capable of red, green, and amber colors.
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trigger

Cause or initiate an action.

tune file

Pre-programmed sounds file that can be attached to a message and sent to a sign equipped with 
speakers in AlphaNet plus™ for Windows® software.

UL

Underwriters Laboratory. Creates testing standards for safety (electrical, shock, fire hazards, and 
so on). Domestic and International. A product tested for safety by UL has a UL label.

update

Change to new values.

UPS

Uninterruptible Power Supply. A device that contains a battery and some circuitry to supply a 
computer with power for a limited time if there is an interruption in the outlet power. 

variable

Represents real-time data that can change, such as temperature or interest rates. Variables can be 
embedded in messages and refreshed when the value changes, and can also be used to trigger 
commands for certain events to start or stop.

ventilated

Provides circulation of external air through the enclosure to remove excess heat, fumes, and 
vapors.

viewing distance

For 20/20 vision, 1” of character height can be read at 50 feet. For 20/40 vision, 1” of character 
height can be read at 40 feet.

WAN

Wide Area Network. Computers that are networked together over a wide geographic area, 
sharing information over telephone lines and radio waves.
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wavelength

A measure of color saturation in nanometers. See also brightness and luminance.

WAWN

Wide Area Wireless Network. A group of computers that are connected wirelessly over a wide 
geographic area. A transmitter attached to a PC broadcasts data to devices equipped with a data 
receiver. 

wireless connectivity

A wireless connection in which a transmitter is attached to a PC, and each sign is equipped with 
a wireless receiver. This allows text and graphics to be sent wirelessly to the sign.

workstation

A computer node through which a user can access a server or other nodes.
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